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The typical CTP workflow

In case you absolutely do not have any time to deal with this manual, please
take at least a look into the main 9 steps to be taken in CTP to create basic
cartoon animation.

However, we would like to encourage you to take the chance reading this
manual. Otherwise you may miss many of the features CTP has to offer.
As a result it may cost you more time finding out “the hard way” than
investing some time with this publication.

CTP is quick to learn and easy to operate. All production steps are performed
in a single program window. In addition, CTP comes with a self explaining
English user interface and with a detailed online help system.  

After creating the drawings, you can immediatly begin working with CTP. 

1.) Use the Import Tools button for images and sound and load all your raw
materials for your cartoon animation into the Storage Sheet. Import your
drawings as files or from your scanner or from your video camera. Import
your audio as files or record it directly in CTP.

2.) For editing and animating, copy your raw materials from the Storage Sheet
into the Exposure Sheet using drag and drop.

3.) Check all your actions in realtime using the Visualization Area. You can
play your animation forward, backward or as a loop at a single click of your
mouse.

4.) Apply animated pans, zooms and rotations to your drawings. Animate the
opacity, brightness, blur and revive your drawings. 

5.) Add painted, fotographed or filmed backgrounds and create the desired
scenery for your production.

6.) Add sound and teach your characters to talk and to sing. 
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7.) Paint your drawings and characters with the Paint Tools. Use brushes, fill
tools and airbrush tools and give your characters a unique look. Add as many
image effects as needed. 

8.) Even complex actions with many characters are easy to create, since you
have up to 200 single layers to place your drawings, foregrounds,
backgrounds and movements as needed. 

9.) When finished, export your completed production as video or sequence of
images. CTP supports all usual video and graphics formats and industry
standards such as AVI, Quicktime, Flash, DVD, PAL, NTSC, HDTV,
Academy, Super 35, VistaVision, 2k, Cinemascope and many more.

Please take a look at the following screenshot. It shows, where the tools
above mentioned are located in the CTP user interface:
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1. What is CTP?

CTP is a custom designed program for making animated series. With it, you
can carry out each and every step required to complete any animated
production for film and television.

CTP is designed to give maximum efficiency in the production of series and,
to this effect, superfluous and unnecessary operations that would only make
the software slower, more costly and complex have been eliminated. Instead,
this time has been invested in optimizing, facilitate and compacting the tools
needed for production. A clear example of this philosophy is its interface,
where all operations are always available, without modules, without endless
windows, with everything at first sight and organized in a simple manner.

This type of design allows you to master CTP and be productive in a very
short period of time. And all of this with the guarantee that your productions
will always have the best broadcast quality.

CTP also incorporates a modular approach. Besides the two “suites” CTP Pro
HD and CTP Pro SD, which contain the full functionality described in this
manual, there are three "satellite" versions, which take the most popular
features from the CTP Pro editions, and make them available as task-specific
groups of functions. The follwing “satellites” are available:

CTP Pencil Test
CTP Paint
CTP Scan

The output of each of the “satellites” is fully compatible with the CTP Pro
versions and offer the exact same easy to learn user interface. 

Last but not least, besides the two CTP Pro versions and the CTP satellites
Pencil Test, Paint und Scan, we also offer another “suite” with a few
restrictions. 
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For web applications, DVD productions or ambitious private users, CTP
Home may be an ideal solution, as it offers most of the functions of CTP Pro.
However, the maximum resolution and the number of layers are optimized to
the purpose.

The following product comparision will give you an exact overview of each
of the version´s feature set.

Please remember: This manual always describes the functions of CTP Pro
HD. 
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1.1. Information on the use of CTP

1.1.1. Content of this Guide
This guide is divided into various sections that will lead you to becoming
familiar with the functions of CTP quickly and easily. This Reference Guide
will lead you, step by step, through all production phases in an introductory
way. For further details on the functions of the operations available in CTP,
see the on-line Reference Guide. In the Reference Guide, each and every one
of CTP on-line operations are explained in full detail.

1.1.2. Integrated help system
Once you have opened CTP, you can press the F1 key, or go to the Help
option on the menu bar to request help. You can select the topic you need help
on from the Reference Guide table of contents or alphabetical index. Using
the search option, you can also look up specific “buzz words”.

1.2. Installation

1.2.1. System requirements
To use CTP, you do not need a special computer system. In principle, any PC
of the last three or four years will be all you need to use CTP successfully.

The following operating systems are supported:

Windows XP
Windows Vista (*)
Windows 7 (*)
Windows 8 (*)
Parallels Desktop for Mac, VMWare or Boot Camp

(*) CTP will work on 32 bits or 64 bits versions of Windows Vista, Windows
7 or Windows 8.

CTP is designed to take full advantage of all system resources. Any
improvement with regard to the minimum characteristics of the processor,
memory, graphics or disk can considerably improve the final result.
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CTP supports the TWAIN scanning standard. This means that any 100%
TWAIN compatible scanner should work flawlessly with CTP. Use an A4 or
A3 scanner with USB or SCSI interface. Scanners with an Automatic
Docoment Feeder (ADF), that is supported through the TWAIN driver, are
fully compatible to CTP´s scanning capabilities. 

CTP supports the Video for Windows compatible Osprey video cards from
Viewcast to be used for so-called line tests via an analog video camera. 

Alternatively high quality USB webcams can also be used for line testing.  

Last but not least, a graphics tablet may be useful to directly draw in the  CTP
software. CTP supports all Windows compatible graphics tablets with USB or
RS232 interface. WACOM professional graphics tablets, such as the Intuos
series, are fully supported.

1.2.2. Technical support
Each copy of CTP includes unlimited telephone and internet support through
the Crater Software website or via email.

Contact information:

Crater Software
c/o Digital Broadcast Systems GmbH
Oberhoechstadter Strasse 10
D-61440 Oberursel
Germany

Phone +49-6171-582010
Fax +49-6171-582012

Email:
· General information: info@cratersoftware.com
· Technical support: support@cratersoftware.com

Internet: www.cratersoftware.com
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1.2.3. Installation
· With Windows running, insert your CTP CD in your CD/DVD-ROM drive.

· If the install program is not executed immediately, select Start > Run on the
Windows toolbar. Locate the SETUP.EXE file on CD/DVD-ROM with the
explorer by clicking on the Browse button. Click on the OK button to execute
the Setup program.

· If you have obtained your CTP software via download, double click on the
install file and follow the given instructions.  

1.2.4. Licensing and registration

The CTP software requires to be licensed and registered. The license is tied
to your computer hardware. If you need to change your computer system, you
can do so anytime. Please refer to the section Un-Registering the license key
on the next page. 

If no license key is available when the software is started, a dialog window
will appear, which will ask you to enter your license key.

Single user license

In a single-user environment, simply click on the CTP icon on your desktop,
after the software has been installed.

A window will pop up letting you know that a license is required. Click on
the OK button and you will proceed to another window that will inform you
of the computer’s hardware fingerprint.  

The hardware fingerprint consists of eight (8) characters divided by a hyphen.
Numbers 0 to 9 and letters A to F only will be used (please notice that 0 is
ZERO, not the letter O).
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Please click on the Register Now button and fill in the online form in order
to obtain a valid license key. As soon as you receive your license key, simply
repeat the steps above again, but enter the given name and your license key
this time.

Click on the OK button once you have entered name and key correctly.

Your CTP software now is permanently licensed and ready to use.

How to un-register CTP and transfer it to a new computer 

In case you need to transfer your CTP software to a new computer, it is
necessary to unregister your CTP license in due form. Once you unregister the
hardware-locked key, it will give you a code to confirm that the key has
actually been removed. You will need to run the UNREGISTER function. It
will guide you through the process and give you the unregister code. Without
UNREGISTER code you cannot obtain a new license key. 

Please perform the following steps if you would like to change your computer
or your hard drive:

Navigate in the Windows program menu to CTP UNREGISTER and click
on it (e.g. Start > Programs > Crater Software > CTP Support > CTP
UNREGISTER):
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A confirmation dialog will appear to ask if you really would like to unregister
CTP:

Copy and note the shown Unregister Code and confirm you have done this by

clicking on the three confirmation buttons 1, 2 und 3. Confirm by clicking on
the OK button:

After installing your CTP software on the new computer, do not forget to

document the new hardware fingerprint for future reference.

If you have any questions concerning unregistering a CTP license and
transfering it to a new computer, please do not hesitate to contact us via email
to support@cratersoftware.com
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Setting up a Multi User Network License

Setting up a multi user or network license is similar to setting up a single user
license.

The difference is, that a network license is able to license more than just one
CTP seat. The CTP workstations must be part of the same network and must
have a permanent connection to a server or „license serving“ CTP
workstation.

The successful setup of a CTP network license is easy, however you should
have some networking knowledge and an already properly working network.
Have your systems administrator do the job.

Important: You will need the network version of the CTP Pro software.

During installation you have several options:

The full installation consists of the software for a CTP seat (CTP Client
Install) as well as the server components for the network licensing (CTP
Server Full Install). Choose both if the computer serves as CTP license server
and CTP workstation at the same time.
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For CTP license serving install the server component.

For a CTP seat install the client component.

After installing the CTP server software click on the CTP Server icon on your
desktop:

Follow the instructions under Single User License as
described on the pages 16 and 17.

After entering the license key start the CTP Server.

A Windows Security message might come up.

Confirm the message. Otherwise CTP Server will not be started.

As soon as the CTP Server has been
started, you have access to the number
of CTP network licenses on your
network. In the example to the right
you have up to four CTP network
licenses.
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In this example, it means you can have up to four CTP seats up and running
at the same time. Granting a license to the CTP seats will work on a „first
come, first serve“basis.

The dialog also shows the status, for
example the licenses currently in
use, how many are still available, or
when licenses have been granted.. 

As soon as a CTP client exits the software, its license will be automatically
returned to the CTP Server and can be granted to another CTP seat anytime.

This means that the CTP software can be installed on as many computers in
the network as you like. However it is only possible to have as many
concurrent CTP seats up and running as the maximum amount of licenses you
have purchased.

If more licenses are requested than are available you will get the following
messages:
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2. Executing CTP

2.1. Basic concepts

Before running CTP, we will define a series of basic concepts that will appear
throughout this entire guide and are the basis of the CTP operation.

CTP can generate two types of documents:

· Scenes: These store all the information with which we are going to work
when creating an animation scene; drawings, sound, camera effects, etc.

· Color Model Archives (CMA): These archives group together a series of
Color Models, generally created by the Art Director, that are later on used as
color references to add color to the drawings of each scene.

Within these two types of documents, we can distinguish two types of
images:

· Drawings: All line images captured in black and white that are to be colored
afterwards will be called drawings. These images are special in as much as the
program assigns them two independent layers, one for line art and another for
the paint or color. This type of images are shown with normal text codes on
the storage and exposure sheets.

· Color image: This other type of image has just one layer, and is presumed
inked and painted and, therefore, cannot be filled as the above. This type of
image is used when inserting already painted backgrounds or overlays in a
scene.  This type of images are shown with bold text codes on the storage and
exposure sheets.
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At any time, when working with these images, you can see on-screen:

· Line mode: If this button is pressed, the program will display only the line
art layer of the drawing type images.

· Fill mode: With this option running, the program will display only the color
layer of the drawing type images.

· Line + Fill mode: This option displays both the line art layer as well as the
color layer of the drawing type jointly combined. The line art layer has
priority and is always on top of the color layer. 

The previously mentioned color images are always visualized independent of
the option selected. These options affect all CTP processes, giving the
program a unique versatility.

There are a couple of general operations you should be familiar with:

· Auto OK: Whenever an operation is carried out on an image, the ok! and
no! buttons on the main toolbar are activated. If no! is pressed, said operation
is cancelled; but if anything else is pressed (such as another operation), the
last changes will be approved automatically as if the ok! button were pressed.

· Selection of cells: To select cells, click and drag the mouse over the area to
be selected. You can select a group of layers, thus including all cells that
belong to these layers, a group of frames, with the same effect, or directly a
group of diverse layers and frames. Once selected, if the mouse is released
and then clicked again and then dragged over the selection, said selection can
be moved within the sheet, which will be explained on further chapters.

To cancel your selection just click the mouse anywhere on the sheet outside
the actual selection.

CHAPTER 2

25Executing CTP



2.2. Running CTP

To run CTP, select Start > Programs > Crater Software > CTP on the
Windows task bar. Upon starting, CTP will display the startup dialog where
you can select whether you want to open or create a scene.  Such window is
divided into three sections: Operation, Select the scene to open, and
Name.  

· To open an existing scene, activate the Open an existing scene option
from the Operation’s section. The white circle to the left of the name should
contain a smaller black circle to indicate it has been selected.  

The Select the scene to open section will display the existing scenes.
From the list, select the scene to open by clicking on it.  It should invert its
color to indicate it has been selected.  

Press OK. The scene you selected will open right after.

· To create a new scene, activate the Create a New scene option from the
Operation's section.  The white circle to the left of the name should also
contain a smaller black circle to indicate it has been selected. 
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Once it has been activated, a new box on the bottom left corner of the Startup
dialog will be enabled.  

Drag your mouse to the Name section and click on it. Then, write the name
of the new scene to create.  

Press OK.

The Scene properties window will be displayed. Setup each parameter
based on the descriptions given below.

· Name: The name chosen for this scene.

· Chapter: The number of the chapter to which this scene belongs.

· Sequence: The number of the sequence to which this scene belongs. If
you do not use this value, leave it at its initial zero value.

· Scene: The scene identification number.

· Output Format: Establishes the resolution automatically for several
standard formats. If specific setup is required choose the other option and set
the following parameters:

· Width:  frame width measured in pixels (8192 maximum). 
· Height:  frame height measured in pixels (8192 maximum).
· Frames/second: Establishes the video refresh frequency.

Scene properties General section
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· Fields: The field size equivalent to a full frame resolution.

· Description: Here you can include notes about the scene.

· This section includes the names of everyone related to this scene. The use
of these fields is optional.

After you have completed these sections press OK. The CTP desktop will
open with the new scene ready to be used.

Note: When installing a newer CTP version the older version’s files, as well
as the Villy the Devil scene and CMA, will be overwritten, but
keeping the saved scenes and Color Model Archives without changes. 

Scene properties Staff section
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3. Working with CTP

This is the CTP desktop where, with the use of all the elements, each scene is
created. All these elements will be fully described throughout this and the
following chapters.  

Clicking on the View menu and activating the Full Screen option will show
the CTP desktop with no borders, allowing  more area to be visible on-screen.
On the other hand, no minimize or close window buttons will be visible. In
order to change it, follow the same procedure as explained above, but
deactivating the Full Screen option instead.
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3.1.  Standard toolbar

The Standard toolbar contains all the usual file
management commands and clipboard
operations, such as New Scene, Open Scene,
Save Scene, Undo, Scene Properties, Print, Cut,
Copy, Paste and Delete.

3.2.  Exposure toolbar

The Exposure toolbar contains the editing
commands, such as Activate/Deactivate layers,
number of Repetitions, Add/Remove layers, cells
Composition, cell Merge, audio Stretch &
Squash, audio offset.

3.3.  Storage toolbar

The Storage toolbar contains the capture
commands for the actual scene, such as, Import
images from File, from Video Input, from
Scanner, as well as importing sound from File, or
Sound Card.

CHAPTER 3

31Working with CTP



3.4.  Color Model Archives toolbar

The Color Model Archives (CMA) toolbar is
composed of the commands to create/open
CMA, Save CMA, as well as CMA display area
functions such as Real Size and Fit to Window.

3.5.  Storage Sheet
The storage sheet is one of the most fundamental
parts of CTP. There, we store all the information,
both images as well as sound, pertaining to a
specific scene. This sheet can store only original
material and does not allow any sort of editing,
except for deleting unnecessary material. In this
way, we can always capture original material without having to rescan it or
recover it in any other way, should there be an error in editing the scene. All
the information on this sheet is always stored within the scene.

3.6.  Exposure Sheet
If we have said that all the images and sound are
stored on the storage sheet, the exposure sheet is
used for the animation editing. On this sheet, we
can join together all animation components so as
to complete the scene animation. 

3.7.  Visualization area
The Visualization area displays the resulting  art
work from the Exposure Sheet, this is, the
compositing of each frame, selected frames,
layers, and the scene as a whole.  By default, this
area has a gray background color.  Whenever an
image operation is performed, this color will
change to a reddish tone to indicate you are about
to change the data on the exposure sheet.
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3.8.  Confirmation button                    
As stated on the previous chapter, the OK! and
NO! buttons are activated whenever an operation
is carried out on an image.  They are used to
approve or cancel the last operation, respectively. 

3.9.  Image Processing tools                     
The Image Processing tools are used to carry out
general changes on the image, such as Vertical or
Horizontal flip, and Replace Color, as well as
general color changes on a color model:
Brightness, Contrast, Color Correct, Blur, and
Opacity.

3.10.  Paint tools                                    
The Paint tools contain a paint toolbar (get color,
fill, eraser, paintbrush, airbrush, line and drag
image buttons), brush functions (size,
smoothness, opacity), a present/previous color
display, a user’s color palette, and a color selector
toolbar.  By clicking on the Selector button you
can adjust the hue, saturation and value of the
color as preferred.

3.11.  Camera graph                            
Whenever a camera cell is active in the Exposure
Sheet, the camera graph will be shown on-screen.
Camera movements can be X&Y Pan, Zoom,
Rotate, Blur, and Opacity. Also, units can be
given either in pixels and percentage, or in fields.
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3.12.  View tools
The view tools are divided into five parts:

3.12.1.  Dialog toolbar

The Dialog toolbar contains the following option
buttons: Full Size, Field Chart, Reference Frames
or Layers, Sequence, Move Display, Zoom
Display, Real Size, and Fit to Window.

3.12.2. Display Mode                                           

As stated on the previous chapter, when working with images you can see
each frame in three different modes (from left to right):

·  Line art mode: if this button is pressed, the program will display only the
line art layer of the drawing type images.
· Fill mode:  with this option running, the program will display only the color
layer of the drawing type images.
· Line+Fill mode:  This option displays both the line art layer as well as the
color layer of the drawing type jointly combined.
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3.12.3. Playback controls

The playback controls allow you to do the following:
· go to the first frame, previous frame, next frame, or last frame either of the

exposure sheet or of the animation, if you are on play mode.
· Play backwards, stop, play forward, and loop the animation.
· You can also carry out the playback function using the video card of your

computer.

3.12.4.  Explorer                                                  

This window displays an outline of the current
format of the images present in the visualization
area. A red box will indicate the actual
visualization area size. Click in the inside and drag
it to the desired location.  

3.13.  Status bar

The status bar is located at the bottom of the CTP window with the following
information:

· Continuous display of used physical memory and free disk space (of the disk
where scenes are saved). It is also indicated with a color scale gadget next
to it, going from green (plenty memory available) to red (little memory
available).

· A progress dialog shown for time consuming operations, such as renders
and other intensive display operations.

·  Help tips which will relate to the actually selected operation and the mouse
pointer location.
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3.14.  Integrated help system

Please use the help system which is integrated into CTP!

The CTP help system offers a lot of help information and many tips and tricks
for all functions of CTP - in addition to this printed manual.

The CTP help system is interactive. This means, that you can click on any
provided screen shot. As soon as you do so, you will be automatically taken
to the respective portion of the help system. Apart from that you will also find
many links you can click on, which will take you to pages with additional
information.

Please do not forget to use the search function which is part of the CTP help
system. Simply enter the term you would like to know more about and have
the existing information listed for further selection.

Hint: The CTP help system is integrated in your CTP software. It will not
open an internet connection and go online.
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4. Importing images  

The import images process allows obtaining the images that will form part of
the animation. These images will be stored on the storage sheet and, later, you
will be able to move them into the exposure sheet in order to edit the
animation. There are three different ways of capturing images: from file, from
video input, and from scanner.

Depending upon the type of job we are going to carry out, a rough line test, a
cleanup line test or the fill in and editing of the final animation, you should
use the proper method. Obviously, this will also depend upon the possibilities
of your present equipment. To capture preliminary material you can use a
camera that, even manually, can be faster than a scanner with automatic
feeder. For final line artwork, only the scanner option has any sense, and to
import any externally created images like 3D backgrounds or live digital
footage, use the file import option.

All the image retrieving operations detailed below store their information on
the storage sheet. These images will be stored in consecutive cells of the layer
selected for this purpose. If you need to remove any cells from the storage
sheet, simply select the range of cells to delete and press the Del key or the
Delete tool button on the file toolbar.

Whenever a new cell is added to the storage sheet, most of the time, it will be
assigned an automatic cell code. To change this code press F2, or double click
on the cell, and write the new code. Press ENTER to confirm changes.
Remember that cell codes must be four digits followed by an uppercase letter.
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4.1. Image file import

If you wish to import images made with other programs, press the import
images from file button to access the import images window. Actually, CTP
can import/export the following image file formats:

AVI
BMP (no compression, RLE compression, OS/2 BMP)
CTP (CTP proprietary format)
EPS Encapsulated PostScript
EXIF
Flash (SWF, export only)
FPXK Kodak FlashPix
IMG GEM Image
JPEG
LEAD
MAC MacPaint
MSP Microsoft Paint
OS2
PCT MacPict
PCX ZSoft PCX
PDF
PNG Portable Network Graphics
PSD Adobe Photoshop 3.0 (RGB single layer only)
Quicktime (requires Quicktime to be installed)
RAS Sun Raster
SGI/RGB Silicon Graphics
SGI(/RLE
PIC Softimage
TGA TARGA
TIFF (RGB, CMYK, YCbCr and PackBits compression)
Toonz (TZP, TZU)
WMF Windows Meta File
WPG
YUV Digital video format (NTSC and PAL)

Note: LZW compression is not supported on any of the above formats.
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You can import/export Alpha Channel whenever the format files used
support it.  Whenever an image containing Alpha Channel is imported,
because being the transparency channel, Filter Options for that type of
images won´t be available. If you want to enable the Filter Options, import
those images without their correspondent Alpha Channel or, what is the
same, 24 bits per pixel images.  

Subsequently, use the selection tabs to modify the parameters for each of
these sections: Files, Sheet, Image and Filter options.

4.1.1. Files section

Use the Files tab section to determine what files to import.

1. Press the file selection button, located at the right of the Folder box. You
will enter a typical explorer window. Locate and select the name of the file to
open and press OK. The path to the selected file will be displayed in the
Folder box, and its name in the Name box.

If you have selected a file which belongs to a sequence of consecutively
numbered files, CTP will try to determine the file name numbering format. If
it can figure out the sequence, it will show the selected file name with a
symbol "#" where the sequence number appears. If it cannot figure out the
numbering pattern, it will simply show the selected file name. In that case you
should place the "#" where required to identify the sequence. With this
method, you will be able to import full sequences of images easily in a single
step.

2. Choose if you want to load the whole sequence or just a single file by
enabling/disabling the Sequence option. If you choose to load a single file,
it will be the one you selected initially from the browser.

3. If you selected the Sequence option, now you will have a chance to
establish which range of frames you would like to load from this sequence.

CHAPTER 4

40 Importing Images



· At the First box enter the file number of the first image to import.
· At the Last box enter the last file number to be imported.
· At the Step box enter the import step desired. A step of 2 will load one out
of every two images, a step of 3, one out of every three images, and so on.

You can use the Current box and slider to set which image to view on-screen
from within your sequence. You can use this feature to check if the selected
sequence is the expected one or to test the import filters on any of the sequence
images. You can also use the Get Frame buttons to place the Current frame
number in the First and Last boxes.

4.1.2. Sheet section

Use this section to select where you want to store the imported images.

The Frame Resolution area shows the actual scene field and pixel
resolutions as a reference for you.

· Cell code: use this field to enter the code of the first cell to be imported.
The format of this code must be three digits and a capital letter (ex. 001A).
This code will be increased automatically with each imported image.

· Image layer: use this field’s drop down menu to select on which storage
sheet layer you want the imported images to be stored.

· Shadows Layer: use this field’s drop down menu to select the storage
sheet layer in which you want the shadow images to be stored. This option is
only available if the Shadow lines filter option from the Image tab has been
activated.

4.1.3. Image section

Use this section to establish which type of image you are about to import.
This section will only be enabled if you have already selected some readable
files to process.
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· Color image: activate this option to import color images like painted
backgrounds in full color. These images will only have a single color layer
and will appear with bold letters on the storage and exposure sheets.
Transparent color: use this option to scan overlays. It will set as transparent
all the white areas on a color image.

· Line image: activate this option to import line drawings. These drawings
will be setup with two layers as explained in earlier chapters, a line layer and
a color layer. After import, the line layer will contain the captured data and
the color layer will be empty, awaiting to be colored in. This type of image
will appear with standard letters on the storage and exposure sheet.

Shadow lines: enables the shadow line processing. This process will
detect bright color lines (red, green, blue, etc) which mark the shadow
areas. If not active, the line art image will only be seen. When active, the
display area will show the current image with the added shadow lines.
This option will output two images, one with the usual line art, the other
with the added shadow lines. Select the shadow line images destination at
the Shadows layer option from the Sheet tab.

Opaque closed areas: this option fills all closed areas with opaque
white color. This option avoids having to fill in closed white areas.

The Image size area will show the current image’s resolution in pixels. You
can directly modify the image clipping area by typing in the new size.

Activate the automatic peg detection to show the peg bar on-screen and, in the
same way, you can enter the peg bar’ size manually, given in dpi.  

· Shadow line colors: Shadow lines are now easily picked up by CTP
using a better algorithm, that is based on better color depiction.  It can now
use specific color tones in the HLS color model, instead of classifying all
colors (other than black and white) as shadow lines.  The algorithm requires
the user to provide specific parameters, especially the Saturation value (which
can vary from a production to another), as well as a choice of color ranges
(this second step is particularly important and effective when an ultra-high

CHAPTER 4

42 Importing Images



quality scanner is used, which can lead to multiple colored lines instead of a
black line), by using certain Hue ranges.

Adding more saturation is simple; but the second part needs more thought on
the animator's side.  The user needs to test the scanner with a first set of color
ranges (for example, if the scanner decomposes a black line in different
shades of red and blue, or indigo, the user will have to tell CTP that it should
pick up colors that don't fall into those color categories, i.e. anything that is
green, yellow, cyan, orange, etc. should be picked as shadow colors, all the
rest is considered black pixels).  When the colors are determined, we tell CTP
to use specific colors with a control like this one:

The Saturation value can be incremented using the Color Saturation box.  A
total of 255 is allowed including the original Saturation value in the first
algorithm.  The Hue Threshold box defines the number of degrees left and
right of a Hue axis to be included in the shadow colors.

The following represents (poorly) what is actually allowed when specifying
Yellow and Red color ranges, with a Hue Threshold value of 30 (Saturation
starts at a minimum value of 51):

The stars represent the selected range.
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Here is an example of an image that was scanned without the algorithm:

Now here is the same image that was scanned with the following parameters:

Colors allowed as Shadow lines: Red
Hue Threshold: 10 degrees
Saturation added value: 0

Many line segments are now black instead of the original blue, yellow, etc.
lines that were mistakenly scanned.
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4.1.4. Filter section

Use this section to select and setup the cleanup filters and their parameters.
This section will only be enabled if you have activated the Line image option
on the Image section.

Above the Filter Section you will find a tool bar with four buttons. These
buttons allow to control the prefiltering of the line images.

For the prefilter you have four functions to chose from: Prefilter´s Black
Level, Prefilter´s White Level, Automatic Prefilter, Reset Prefilter. 

Prefilter´s Black Level: This button has an image of a black eyedropper on
it. When you click on the button, a black eyedropper-shaped cursor appears.
In the viewing area, click on the line on your drawing to select the dark areas
of your line drawings.

Prefilter´s White Level: This button has an image of a clear, transparent
eyedropper on it. When you click on the button, a transparent eyedropper -
shaped cursor appears. In the viewing area, click on the areas of your drawing
to select the areas that you want to appear transparent (i.e. the blank areas of
your drawing that you want to fill with paint later).

Automatic Prefilter: The Auto button makes an automatic calculation of the
Shadows and Highlights (dark and light areas) on your line drawings. The
Auto tool automatically adjusts the image so that the darker grays appear
black and the brighter grays go up to white (transparent). The rest of colors
will be adjusted accordingly.
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Reset Prefilter: If you sample the Shadows and Highlights on your line
drawings, and you sample the wrong areas, the Reset button clears all of the
Prefilter settings so that you can start over. The Reset tool simply resets all
values so that no Prefilter is applied.

Important: To use the Prefilter tools effectively, turn on the Transparency
button (the red button with the line through it). When you click on this button,
all the pure white areas on the image you are scanning are displayed in red.
Wherever you see red, those areas are considered to be 100% transparent by
the CTP software. It is these transparent areas that will be painted in later. The
red areas provide a visual reference, letting you see exactly which areas of
your drawing are truly white, and which ones are gray or off-white. Any part
of your drawing that is not pure white will be considered as part of a line or
as an opaque area by the software. The image transparency button is very
useful in conjunction with the prefilter options, because it lets you see the
contrast between the lines and the white areas on the drawing very easily.
Now you can keep on clicking on the dark areas with the Shadows selector
(the black eyedropper) and the lighter areas with the Highlights selector (the
clear eyedropper) until all the lines in the image are surrounded in red.
Always leave some white between the black lines and the red surroundings,
this adds smoothness to the lines.

In addition to the prefilters you can and should also use the existing cleanup
filters. You can use these filters on every black/white or greyscale images.

· Only prefilter: no filter is applied.

· Camera: this filter works wonders on low contrast images (usually those
obtained through camera input). This is the recommended filter for camera
line-test grabbing.

· Scanner: this filter is intended for images obtained with a better quality
(usually from scanner). It will strictly try to find the lines drawn on the image.

· Opaque Lines: this option, only available with the scanner mode, will
guarantee that the line is always totally opaque at its center giving the best fill
results.
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To cleanup an imported image, you will need to setup the following
parameters properly. Every filter type will maintain its parameter setup even
if you close the Import Images dialog. The only exception is the Opaque
lines option which offers the same Sensitivity and Highlight values as the
Scanner option.

· Sensitivity: adjust this parameter until the background areas appear white,
but making sure the lines don't appear broken. Place the slider at its rightmost
position and drag it slowly to the left until you see a clear difference between
lines and background. This slider is not available with the Artistic filter.

· Highlights: use this slider to trim down the light gray areas surrounding the
lines. Moving it to the right will give you a thicker, less defined line with gray
noise around the lines. Drag the slider to the right until a well defined line,
but without loosing the slight blur that avoids seeing the staircase artifacts of
very rough lines.

· Shadows: once you get a clear line with the above parameters, use this
parameter to darken the line. Most of the time you will be able to darken the
line to absolute black by dragging the slider to the right. Be careful not to
make it too dark and start loosing line quality.

· Softness: after setting up all the previous line parameters, you can always
use this parameter to apply some soft blur to the final images to help avoid
any rough edges that may be left.

Some trial and error will be required to set these parameters to their optimal
values, but the better the input quality the easier it will be. If you are inputting
a sequence of images, try to test the set values on several key images and find
the value range that works for all of them. Once set, you will be able to input
the entire sequence with no further parameter modifications.

Note: To move around the display area, you can press on the space bar while
clicking on the left mouse button.  To zoom in/out the image, follow the same
procedure, but pressing the right mouse button.
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4.1.5. Image Import toolbar

The import toolbar is the same for all three import dialogs (Import from File,
Scanner and from Camera):

Click on the real size button to view the image at pixel to pixel size.

Click on the fit to window button to view the image scaled down or up to fit
the whole dialog display area.

This is the white check button, when activated it indicates which pixels are
totally clean and which are not. Pixels 100% transparent are shown in bright
red color. With this option activated, you will be able to adjust your filtering
parameters more precisely.

Press the Shadow Image button to activate/deactivate the shadow lines view.
When the Shadow Lines option on the Image tab is active, CTP will import
two images, the standard line image and the line + shadow line image. Since
the shadow line search algorithm is quite complex, the Shadow Image button
will allow you to see, before import, how the shadow lines are being
processed. To get back the standard line image, click again on the Shadow
Image button.

Press the Clip image button to activate/deactivate the image area to be
imported.  When not active, the whole image will be imported and filtered.

Click on the field chart button to view the field guide overlaid on the display
area.

Press the Pegs button to activate/deactivate the automatic peg bar detection.   

Press the Lock Peg Bar button to enable/disable peg bar relocation. Once the
peg bar is set at its correct location and the field chart has been placed
correctly relative to the peg bar, it is important to lock them to avoid possible
incorrect registration of the imported images. Whenever the Lock is active
you will not be able to select neither the field chart nor the peg bar.

Click on the Horizontal Pegs button to show the pegs horizontally on the
display area.
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Click on the Vertical Pegs button to show the pegs vertically on the display
area.

Note: Whenever you want to modify one of the three settable elements on the
display area (the clip box in red, the field chart in green, and the peg bar in
blue), just place the cursor over it and click the left mouse button. The
smallest object under the cursor is the one that will be selected and when
activated it will be displayed with a solid line. The other unselected objects
will be displayed with dashed lines.

When closing any of the import dialogs and the parameters have been
changed, the program will ask if you want to set them as the scene’s default.
That way you can always go back to the dialogs and use the same parameters
when needed.  

4.2. Importing images from video input

If you wish to import images from camera, press the import images from
video input button. 

After selecting the video card or webcam drivers, the following screen will be  
displayed.

When using the camera capture tool make sure
your video I/O and camera settings are setup
properly to get the best possible image from
them. Press the Source, Display or Format
buttons at any time from the capture window
to access the video setup panel. 
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The dialogs you can see here are just
examples, since they depend on the driver of
your video card or webcam and might look
different in your CTP software. The Display
button may only be active in certain
situations and might also be without any
function in your setup.

By default, the preview display area will show a live image of what the
camera is viewing. Press the Adjust Filters button at any time to freeze the
actual camera input and try the filters on it. To go back to the preview mode
after adjusting the filters, press the Live Preview button.

As with image import window, this one is also divided into different tabbed
sections: Sheet, Image, and Filter options. Their functionality is similar to
the one explained for importing images from file. The only difference being
that the Image and Filter options are only active after pressing the Adjust
Filters button.

Once you have set all parameters as desired, click on the Import button to
import pictures from video.

Hint: All import parameters can be saved as part of your scene.
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4.3. Importing images from scanner

If you wish to import images from a scanner, press the import images from
scanner button. The following window will be displayed.

If this is the first time you use your scanner,
first you should select which device you are
using. Press the Select button and choose a
device from the list of available scanners. 

The names displayed here will not match exactly the name of your scanner,
but they will most probably have some reference to it or its manufacturer.
Choose the one that seems most appropriate. You will only have to do this
scanner selection, whenever you add a new scanner to your system.

Now you can go ahead and scan an image.

1. Prepare the scanner by placing a sheet inside, or loading the automatic
feeder, if available.

2. Press Preview to scan the first sheet. With this image displayed, adjust all
scanning parameters.

Note: The previewed image is already in your computer´s memory. After
setting the scan parameters and pressing OK the image will go straight to the
Storage Sheet without being scanned again.

As with image import and camera capture window, this one is also divided
into different tabbed sections: Scanner, Sheet, Image, and Filter options.
The Sheet, Image, and Filter options work mostly as described previously.
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4.3.1. Scanner

The Source area identifies the selected scanner by showing its model name
and the maximum scanning area specified by the scanner itself. 

· Scan Type: the list of available types will be defined by the scanner’s
possibilities. Select the scan type properly since it can greatly affect your
scanner’s performance.

· Threshold: the threshold fader is used when scanning in black & white.
You can set a specific value to distinguish between the white and the black
areas of your line image. 

· Resolution: establishes a field size equivalent to the size of a video screen.
This value directly affects the scanning resolution and the size of the field
guide overlayed on the display area. With this parameter, you are telling the
program the field size you want to use for a full video frame. Whatever fits
into the display field chart will take the whole video frame size. To scan an
image, that will afterwards be zoomed in down to field 4, put 4 into this
parameter and you will get excellent resolution while zooming in.

· Automatic feeder: select this option to use the automatic sheet feeder
(ADF), if available.

· Multiple pages: select this option to scan multiple pages. To stop a
multiple scan, press the Cancel button at any time. This operation will not
affect the images scanned up to that moment.
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· Hi Res: High-Res scanning mode which doesn’t require the use of any
filters and gives thinner lines! Used mostly with Black & White scanning
mode to make the best use of high speed scanners. This feature uses our latest
down-scaling algorithm. It allows the user to scan in black & white mode (the
fastest there is) at very high resolution, that image is scaled down to the
required animation resolution, and in the process that black & white image is
converted to grayscale with the appropriate antialiasing. Since the images are
scanned in black & white we need a new control, the Threshold slider, which
decides what goes to black and what goes to white. This is decided by the
scanner at scan time taking this value into account. Since the image comes in
so extremely clean (just black and white!) there is no need to apply any
cleanup filters afterwards. 

CTP offers to scan at various High Resolution factors. Available values
include x1.25, x1.5, x2.0, x3.0, x4.0 etc. up to the maximum of x32.0. With
these factors, CTP lets you choose between various quality vs. scan speed
compromises. Factors under or equal to x2.0 have proven great speed, while
factors over x3.0 will provide you with great line quality.

· Audible confirmation: CTP gives acoustic feedback when you are
importing images manually from a scanner or a camera. In other words, once
CTP has captured the image, it will beep at you, using a standard WAV file or
the PC beeper if there is no sound file selected. 

· Auto Scan: This function activates a new timer-based auto import feature.
The user enters the number of images to capture and the time between each
capture. Once you get into a rhythm for changing each sheet or animation
paper at the right time, the timer-based auto-import feature really speeds up
camera capturing and single sheet scanning. Alternatively, you would press
the space bar on the keyboard to capture every image. 

Hint: All import parameters can be saved as part of your scene.
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5. Animation Editing

Once the animation is captured, you can edit it in the Exposure Sheet. This
sheet is based on the classical exposure sheet concept, but using the
advantages given to us by the computer when having to edit. On this sheet we
can join together all animation components to complete the production.

As you will see on the screen, the exposure sheet contains three layer colors:

· The audio layers are identified by their bluish color;
· the reddish color corresponds to the image layers, and
· the green color to the camera animation layers.

You can move around the storage and exposure sheets by pressing on the
space bar from your keyboard while dragging on the left mouse button.  Use
this method as a complement of the standard window scrollbars.  In the same
manner, you can zoom in/out any of the sheets by pressing on the space bar
while dragging on the right mouse button up/down. To restore the sheets’ size,
press the 1:1 button located at their top left corner.
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The splitter button is used to give the maximum space to the visualization
area, determined by the scene’s size. To view the Exposure Sheet to its
maximum size, you can either slide the visualization area bar with the left
mouse button or click twice on the bar to automatically open it up.

To add new layers, select the layer to the left from which you want to place
the new layers and press the add new layers button.  An insert layers window
will be displayed.  Enter the position from which you want to place them.  By 
default it will show the position from where you made the selection.  Enter
the number of layers to be added.  Then select the layer type; image or sound
layer.  The insertion will be made at the right of the Insert Position, and all the
layers will be renamed following an alphabetical order, only first and last
layers will keep the same name: OVL and BGR.

To remove a layer, select the layer(s) you want to remove and press the
remove layer(s) button.

To add a new camera layer, select the image layer to the left from which you
want to place the new camera layer and press the add a new camera layer
button.

To add a global camera, select the last layer to the right of the exposure sheet
and press the add camera layer button. 

You can add any number of layers of any type up to an overall maximum of
200 layers.
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5.1. Copying information from the Storage Sheet onto the
Exposure Sheet

To be able to edit the animation on the Exposure Sheet, we must first copy the
necessary data from the storage sheet onto this sheet.
Exposure sheet              Storage sheet

1. Select a range of cells to be copied
from the storage sheet by dragging your
mouse over them. You can select cells
within the sheet or, for a quicker
operation, entire layers or a set of frames.
Selections can include any type of cells
and can be as broad as you need.

2. Place your mouse over the selection
until a small rectangle appears on the
cursor. Copy the selected set of cells from
one sheet to the other by clicking on the
selection and, without releasing the
mouse button, dragging it to the exposure 

sheet. During this drag operation, you should see a square over the sheets of
a size equal to the number of selected cells.  

3. Once you are in the exposure sheet, the marker will display a “+” sign in
those positions in which it is possible to insert the copy, or a prohibition sign
where this is not possible. Release the mouse button when the square
indicating the dragged selection is at the location where you want to copy the
cells.

This type of operation can be used both to move or copy cells onto the
exposure sheet as well as between both sheets. In the case of working between
both sheets, the operation always results in a copy of the storage sheet data
onto the exposure sheet.  Performing this operation within the exposure sheet
only, the result will be a data move. If the CTRL key is pressed in this latter
case, the result will also be a copy.  Pressing SHIFT when moving or copying
cells will insert them at the given position, moving the other cells (if any)
up/down the layer instead of overwriting them.

CHAPTER 5

58 Animation Editing



When carrying this operation out, the storage sheet is concealing a large part
of the exposure sheet. When moving the data to the exposure sheet, the
storage sheet will hide, so you can see a larger part of the exposure sheet to
drop your data easily.

Note: An interesting feature called Reload From Storage to replace images
on the Exposure Sheet with their counterparts on the Storage Sheet. It only
affects the range of cels selected on the Exposure Sheet. It will replace the
contents of any selected cel that has the exact same name as another one
inside the Storage Sheet. It is extremely useful to replace the Exposure Sheet
setup during the line test, with camera captured rough images, with the later
scanned final images. 

Note: The Rename Cels button on the Storage Sheet allows for automatic
renaming of a sequence of cels. Simply enter the name of the first cel and all
the cels in the selected range will be renamed in sequence. 

5.2. Editing

By carrying out selections of the type described above, you can reorganize the
sheet so that it matches the classical exposure sheet established for this
production. On the exposure sheet you can move, copy, insert, delete and
replace cells in accordance with the options you have selected within the
Options dialog (available through the Tools menu) and the keys you are
pressing. See the on-line Reference Guide for further information.

When carrying out a copy of a cell or group of cells, they will act similarly to
repetitions.  Thus, any changes made in one cell will affect the others.  To
unlink these cells, simply rename them by pressing the F2 key, or by double
clicking on each cell, and entering a new code.  To unlink a range of cells, 
press the U key from your computer and then enter the first new code.
Remember that cell codes have to be four digits followed by an uppercase
letter (e.g. 0001A, CAR01, VILLY).
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Whenever you enter a cell name into an empty cell three things can happen:
1.  If this cell name already exists on the exposure sheet, the new cell will
now contain the same image as all the cells with the same name.
2.  If this cell name does not exist on the exposure sheet, but does exist on
the storage sheet, the cell will now contain the image of the storage sheet,
but without being linked to it. That means, that whatever changes we
make to this new cell will not affect the storage sheet image.
3. If this cell name doesn't exist neither on the exposure sheet nor the
storage sheet, the cell will become an empty white cell with the new name.

Whenever you change the name of a cell that already exists three things can
happen:

1.  If the new cell name already exists on the exposure sheet, you will be
asked if you want to replace the contents of this cell with the ones on the
new name's cell.
2.  If the new cell name already exists on the storage sheet, you will be
asked if you want to replace the contents of this cell with the ones on the
storage sheet cell.
3.  If this new cell name doesn't exist neither on the exposure sheet nor the
storage sheet, you will be asked if you want to change the cell name of all
the other cells with the same name as well.

While editing the sheet, you can flatten a group of cells of various layers to
the cells of the highest priority layer. The order of the layers on the exposure
sheet defines their priorities. The leftmost layer has the highest priority, while
the rightmost layer has the lowest priority. The flatten operation can be used
to clear various layers so as to include new data in them or to flatten the
diverse layers that make up a character that, in any other case, would leave
inadequate open areas for filling in. By means of this technique, you can
virtually handle an infinite number of layers.

1. Select the range of cells to be flattened. Remember that your selection can
include a range of cells or entire layers.

2. Activate the layer you wish to flatten within the selection by clicking in the
box located at the left of the layer’s name, or by selecting the layer and
clicking on the activate button.

CHAPTER 5

60 Animation Editing



3. Press the flatten button. All cells included in this selection and belonging to
active layers, except for those belonging to the highest priority layer, will be
deleted. The cells of this top priority layer now contain the results of the
flatten operation and keep this layer’s original codes.

Note: when flattening images a warning pop up window will be displayed
for confirmation.  Activate the Clip images at frame size option to clip the
selected images’ seen size.  This option is very useful to save memory.  Once
OK has been pressed, it is not possible to undo this operation.

In the Exposure Sheet as well as in the Storage Sheet, there is an unlimited
number of frames.  Therefore, each time the scroll bar hits the bottom part of
the sheet, a new frame will automatically be set.

The Unlink Cels button allows for the unlinking (with automatic renaming as
a consequence of it) of a range of cells. This is very necessary since cels with
the same name can only have the exact same content, they are linked together.
With this option we can generate duplicate cels with the same graphical
content, but totally unrelated, so can apply any kind of effect without
affecting the original cels.

5.3. Display

When carrying out a selection as described above on the exposure sheet, you
will notice that the first cell turns yellow. This is the active cell and the cell
that determines what will appear on screen while carrying out any paint or
image processing operations. If this cell belongs to the image layers, the
image will appear on screen. If, on the other hand, it belongs to the sound
layers, no image will be displayed. If the active cell belongs to an animation
layer, what will appear on screen are the images resulting from the
composition of the active image layers affected by the corresponding camera
layer.
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Clicking on a single cell is like carrying out a selection, but on just one cell.
Therefore, this will be the active cell.

To select a range of cells, click on the first cell to be selected and, while
pressing the SHIFT key, click on the last cell to be selected.

To jump to the previous/next master cell press the CTRL + up/down cursor
keys.

When editing the data on the sheets you can open and close the sheets by
means of the display area and exposure sheet bar. With the first, you can limit
the size of the display area and with the second, the size of the exposure sheet
with regard to the storage sheet (see the graph at the beginning of this
chapter).  In the same way, pressing the toggle button will close the exposure
sheet up to where the visualization area is visible as a whole.  Clicking twice
on the visualization area bar will reduce the display area, thus widening the
exposure sheet.  You can toggle the exposure sheet by pressing the S key from
your computer.  This operation will hide the storage sheet so to obtain a
greater view of the exposure sheet.  To recall the storage sheet back to its
original location just press the S key again.

To view any of the remaining animation layers as a reference, press the Onion
Skinning button and activate the corresponding storage sheet layers.  This
mode is extremely practical during the entire editing process since it allows
you to see the whole frame composition without having to render any
previews.  This reference layer display has a minimum effect on the
program’s performance.  For more information on this matter refer to Chapter
15. Options Setup section Reference (Onion Skinning) tab.

5.4. Animation playback

At any time during the edit of the contents of the Exposure Sheet, you can
carry out a playback to check the results of the modifications made.

1. Activate or deactivate layers, depending upon the layers you want to view.
To change the condition of several layers at the same time, select various
layers and press the layer activation or deactivation buttons. If you press these
same buttons while pressing the SHIFT key, you will activate or deactivate
all the exposure sheet layers at the same time, independent of the selection.
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2. Select the range of frames to be played and press the playback button.  The
program will calculate the render of all the images, and show the playback on-
screen.

3. You may, at any time, stop the playback function and use the typical buttons
on a video unit to move along the animation.

During the playback function, the selected frames appear in light gray on the
exposure sheet to indicate you are in playback mode, during which the
operations allowed are very limited. To cancel the playback mode and
continue editing the sheet, click on any cell of the exposure sheet.

5.5. Animation timing

Always, when working with animation, it is quite usual to find repeated
image cells. To avoid excessive efforts and make editing of the exposure sheet
more efficient, you can repeat any image cell as many times as you like.
These repetitions are identical and are linked, for which reason any change
made on one affects all the rest.
1. Select the range of cells to be repeated. These can belong to different
layers.

2. Enter the number of repetitions needed for each cell next to the repeat
button.

3. Press the repeat button, or the
Enter key, and inserted below each

selected cell will appear as many repetitions as
requested.   These repetitions are counted as of the
primary (or main) cell. If you have selected three
repetitions, they will be setup as one cell with the
code and two with the same code but with a slightly
reddish color.
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If you want to delete the repetitions of any cell, select its primary, or master
cell, and enter 1 as the number of repetitions. Press the repeat button and only
the primary cell will remain.  You can use the + and - keys to add and remove
repetitions.  Once inside the repeat box, you can also use the up and down
arrow keys to add and remove repetitions.  Remember to select the master cell
before adding or removing repetitions.  Otherwise, no changes will be made.
You can press the CTRL + up/down cursor keys to jump to the previous/next
master cell. 

You can also delete cells or its repetitions by selecting a range and pressing
the Del key from your keyboard or the Delete button, too.

A ping-pong effect within cells is also available.  To enable this operation,
first select the cells to be reversed.  Then, either click on the Edit Menu and
select Reverse cells or, for fast exposure sheet editing, press the R key from
your keyboard.  For example, if you select cells 0001A, 0002A, 0003A,
0004A, and then press the R key, the result will be the following:  0004A,
0003A, 0002A, 0001A.

Pressing the right mouse button on an active cell or a group of cells will
display a popup menu.  This menu will allow you to copy, paste, repeat,
reverse, unlink, delete or remove cells.

5.6. Slates

In CTP you can also create and insert so called Slates. Slate images are
usually inserted at the beginning of a scene; the image contains various
information about the scene and usually serves as a guide when the scene is
archived on final media.

To create a slate image:

1.Open a scene in CTP
2.Select the cell in the exposure sheet where you want to insert the slate image
3.Open the Insert menu, then choose the Create Slates… option
4.The following dialog will appear:
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The Staff/Production area
will let you specify the right
information.  You can then
select the information that
you want to appear in the slate
image by checking the
appropriate boxes.

The Slate Configuration area lets you modify the layout of the image.  You
can select a background from a choice of images: Black or Blue backgrounds
(common in productions), use the first available frame from the scene, or use
a specific image (by choosing the Other: choice. If you choose the first
available frame or a specific image, you can blur and/or darken the
background image by checking the Blur and Darken boxes.

You can also specify the font to use by
clicking on the Change Font… button.
Please note that you can also change the
font color by clicking on the same
button.  You can finally add a shadow
(black) to the text by checking the Text
Shadow box.

5. You can preview the slate image by clicking on the Preview button to the
right of the dialog. When you are done with the preview, click anywhere on
the image to close the Preview window.
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6. When done, click on the OK button. The slate image will then be created
and inserted into the current cell in the exposure sheet. Please note, that
adding the slate image in a cell that exceeds the last frame in the scene will
increase the total number of frames and might show the wrong number of
frames in the slate image. Make sure that adding the slate image doesn’t
change this number.

7. Please note, that if you need the slate image to appear for more than one
frame, simply repeat the cell as many times as you want, like any other cell.
Make sure that the slate image doesn’t show on top of any other important
cells; the best way to do that is to start the production at a higher frame (i.e.
frame #72, for instance, with 71 repetitions of the first cell, the slate image).
The OVL layer is usually a good place to put the slate image.

8. The first slate image cell to be inserted in the scene is always called
“SLATE”. If the user inserts another slate image cell in the exposure sheet,
the second cell will be named “0001E”, then the third one to be inserted will
be named “0002E”, and so on. This is because CTP follows the same naming
sequence as with any other cell. The cells will end with the letter “E”,
because, the first one (SLATE) also ends with the same letter.  

The following represents a slate image that was created using the first
available frame from the scene; all Staff/Production boxes were checked, the
background image was blurred:
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6. Capturing sound   

The insertion of sound in the Storage Sheet can be carried out by directly
importing WAV type files, or by directly recording the sound by means of the
audio inputs of your computer (CD, tape, microphone, etc.).

6.1. External capture of sound

To capture a sound through the computer audio card, press the sound capture 
button, which will display the window for this purpose.

1. Prepare the material to be captured, whether it be on tape, CD or
microphone, checking the exact duration of it.

2. Press the record button and start the tape, CD or talk into the microphone.

3. Check the time displayed on the counter located at the top of the window.
When this time is greater than the estimated duration time, press the stop
button.

Once captured, the window displays the amplitude graph of the recorded
sound. If you want to check the recording, use the play and stop buttons at
your own convenience. To replay specific areas, click and drag the mouse on
any area of the graph. Once checked, you must select the necessary part of the
sound and eliminate unnecessary silences.
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1. Check to see which parts of the sound are necessary by means of the zoom
buttons and the playback of same.

2. Clicking on and dragging the sound graph, select only the necessary part of
the sound, but without worrying about precision. You will be able to edit the
sound with precision once it is in the Exposure Sheet.

3. Select the destination layer for the sound and press OK.

The selected sound is stored in the layer of the selected sheet, and the rest is
discarded. The same sound amplitude graph that appears in the record
window will now appear in the selected layer of the Storage Sheet, but
vertically.

6.2. Importing sound files

CTP can import sound files to the storage sheet, in case this material is offered
on some sort of magnetic support. To be able to import a file, it must be of the
WAV type.

1. Select the sound layer from the Storage Sheet to which you wish to import
the sound.

2. Press the sound import button. The sound import window will display the
selected destination layer. By selecting a layer from the storage sheet prior to
pressing the button, you will have already specified the desired destination
layer. You can do this in this way, or by selecting it once the window is open.

3. Use the Browse button to access the Windows explorer and find the sound
file that you want to import. Press OK.

Once imported, and as in the case of capturing, the imported sound amplitude
graph appears in the selected layer.
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7. Sound editing

Sound editing is carried out exactly like the editing of any exposure sheet cell,
selecting and dragging cells. The only difference is that the sound cells are
never considered empty and, if no sound has been entered into these, they
contain silence. Therefore, on all sound layers all cells initially contain a zero
amplitude graph depicted by a straight vertical line.

7.1. Copying sound from the Storage Sheet onto the
Exposure Sheet

The same as with images, sounds cannot be edited on the Storage Sheet and
must be copied onto the Exposure Sheet. Use the same method explained for
animations.

7.2. Sound editing 

We can modify the length of a sound to adjust it to an animation by means of
a stretch & squash operation.

1. Select the range of cells on which you want to carry out this operation.

2. Press the Stretch & Squash button.

3. On the window that appears, enter the new size of the sound in number of
frames, and press OK.

This new size of the selected sound should match the exact number of frames
entered.

In the same manner you can use the offset button to precisely adjust the start
point of the sound. Enter the number of milliseconds of required offset and
press OK.
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Once the sound is edited on the Exposure Sheet, you can listen to the result
by activating the desired sound layers and pressing the play button. If any
image layer is activated, the playback will be both of sound and image and,
therefore, you will have to wait for the render execution. If, on the contrary,
there are no activated image layers, sound reproduction would be practically
instantaneous.

Note: As with images, sound layers can also be flattened together.  Remember
to activate the desired layers to be flattened before carrying out this operation.
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8. Importing backgrounds

The import of backgrounds is carried out exactly in the same manner as the
importing of a drawing, with the difference that a background image, due to
its original size, can be made up of various acquired images which can later
be composed together. The same as these, backgrounds can also be acquired
in drawing mode, to be filled in with CTP, or in color image mode to be used
directly.

8.1. Classical and high resolution scanning

The image scanning process that makes up a background is the same as that
explained in section 4.3.  Importing images from scanner.  If it is known
beforehand that the background is going to be used in a scene with zoom
operations that surpass 200% of the original size, it is important to increase
the scanner resolution to obtain maximum quality. To do this, it will be
sufficient to change the value, on the scanning dialog, of the field that
represents a complete video frame for the value of  the maximum zoom field
that will be applied to this image.

8.2. Capture by camera

Capturing by camera is carried out exactly as explained in section 4.2.
Importing images from video input but, as opposed to the scanning method,
in this case we cannot adjust the capture quality and, therefore, its use is not
recommended for background capturing.

CHAPTER 8

76 Importing backgrounds



CHAPTER 9
Background editing



9. Background editing

Once we have scanned or captured the images necessary to form our
background, we must join them together to form a single image. This new
image is the one that will be used in the final scene. As usual, the first step
will be to transfer the scanned images to the exposure sheet to be able to work
with them.

9.1. Composed images

A composed image is nothing more than a normal image increased in size to
accommodate all subimages that make it up.

1. Select any empty cell.

2. Press the compose button. A window will appear indicating the size (in the
number of subimages) that you want to create. Select the desired size by
dragging your mouse over the window.

3. Press the Full Size button to view the new given cell size.

If you check the image on-screen after this operation, it must contain
sufficient blank space to accommodate the remaining subimages. 

9.2. Compositing

Now you should insert each one of the subimages that make up the
background in their corresponding place within this large white cell.

1. Press the add subimages button. The cursor will become a hand with the
index finger sticking out and a square at the end indicating that you should
select the cell to be added.

2. Click on one of the cells to be added. The image of the selected cell will
appear immediately on-screen, with semitransparent colors and, when the
cursor is placed on it, the cursor will turn into an open hand with a square at
the end.
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3. Click on the new subimage and use your mouse to drag it into position. For
precise position adjustments use the cursor keys. If you want to zoom or move
the screen while making up the background, you can do so with the usual
tools, but remember to reselect the move subimage button when you want to
continue relocating the present subimage.

4. Once the image is in place, press the ok! button located on the main toolbar.
The subimage will then form part of the background image, going back to its
normal color. Repeat this procedure for each subimage until the background
is completed.

Note: when compositing images a warning pop up window will be displayed
for confirmation. Once OK has been pressed, it is not possible to undo this
operation. 

Remember CTP uses two types of images, drawings and color images.
Whenever you compose large images, the result will always be a drawing,
maintaining all the color of color images, unless all images used are color
images.  In this only case the result will be a color image as well.

You can use the cursor keys to move the image more precisely, or press the
SHIFT key to move it by 10 pixel increments.

To facilitate the composition of the images that make up the background, it is
important to scan them with parts that overlap, or you will not be able to
adjust their position correctly.
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10. Painting

After having acquired all images, overlays and backgrounds, its time to fill
these in. This operation can be carried out either directly selecting the color
from the painting palette or using Color Models Archives (CMA).

10.1. Painting  modes

As mentioned in earlier chapters, CTP has three display modes. These modes
will also determine which image layers you are modifying while working
with the paint tools.

· Line mode: in this mode, only the line layer will be displayed and affected.
Use this layer to modify the line shape or color. This is the layer you must use
to close gaps, since the fill algorithm uses this line layer as a reference to
know what it has to fill.  Use this mode when line drawing.

· Fill mode: in this mode only the fill color layer will be displayed and
affected. You will rarely use this layer for painting unless you want to achieve
some unusual effect. The fill tool will not work in this mode since it has no
reference line to work with.

· Line + Fill mode: in this mode both the line and fill layers will be displayed,
but only the fill layer will be modified, using the line layer as a reference. This
is the mode you must work in to fill in your line images with color.

Remember that the line layer always lies on top of the fill color layer and that
these two layers are only available on drawing type images.

Whenever you select a cell to paint on it, CTP will deactivate its camera layer
(although the camera layer on-screen status will not change) so you can work
on the image's neutral position. This camera deactivation will obviously affect
any other cell images affected by the same camera as the actually selected
cell.
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10.2. Adjusting the brush

To use some of the paint operations you will need to adjust the paint brush
format to your needs.

1. Press the button to vary the size of the paint brush. Adjust the size by
dragging the mouse within the window displaying the present paintbrush
format. Moving it upwards will increase the diameter of the paintbrush, and
downwards will decrease it. You can also adjust the value by modifying the
number on screen.

2. Press the button to vary the softness of the paint brush. Adjust the value by
means of the previous method. This softness determines the roughness of the
outlines of the paintbrush. 

3. Lastly, press the button to modify the opacity of the paint brush. Adjust the
value also by means of the previous method.

To select a color for your brush, just click on the color palette located on the
center of the main toolbar, click on one of the user palette colors, or click on
Selector and use the sliders to make a precise selection.  To perform fast and
accurate color selections for your fill operations, the best method is to use
color models. These are explained thoroughly on the next chapter.

The selected color affects almost all operations of the graphic palette. If, after
having selected a color, you want to get back the previous color, click on the
color area beneath the present color box.

Once having established the paint brush format, you can draw on the selected
models with any of the paintbrush, airbrush or line draw tools. In the same
way, you can also vary the paint brush format for the eraser tool, the only
difference being that the opacity of the latter cannot be adjusted (it is always
transparent) and does not take into account the selected color.
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If you wish to select a color from the screen, press the get color selector tool
and click on the area with the desired color. Once the color is selected, the
previous operation will be reactivated so that you may continue to work
without having to reselect this operation again.

10.3. Paint tools

On this section we are going to describe all the paint tools available and how
they will perform depending on what painting mode you are in.

Fill
Line mode: Use the fill tool to color in only the connected lines by clicking
on them. If you press the SHIFT key while clicking on any part of the display
area, all the lines of the image will be colored with the current color. Also,
with the SHIFT method, if you press OK and you have several selected cells,
the system will ask you if you want to modify all the cells in the same manner.
Remember to activate the desired layers before carrying out multiple
operations.  

Fill mode: Not available.

Line + Fill mode: This is where you will fill in the closed line areas of your
drawings. Simply select a color as explained above and click inside any
closed area of interest. The area will be filled using the fill layer, but delimited
by the lines on the line layer. Whenever filling in this mode you will notice
that the actual content of the closed area is ignored. This means, if a closed
area is partially filled with any color, clicking inside of it will still fill it in full,
limited only by its surrounding lines.  Please, refer to Chapter 15.  Options
Setup to know about the Sensitive fill option, very useful when filling in
complex areas.  To fill several closed areas at the same time press the CTRL
key while dragging your mouse to create a box over all the areas you want
filled. Only the areas that are totally inside the marked area will be filled.  
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Eraser
Line mode: Use the eraser in this mode to erase any part of the lines in your
drawings.

Fill mode: This will erase only the fill colors.

Line + Fill mode: This will have the same effect as the Fill mode by itself, but
allowing you to see the Line layer in the process. On this mode it is
impossible to erase the lines.

Pressing the SHIFT key while using this tool will erase the entire display area
contents affecting the selected mode layers. If a range of cells have been
selected, this operation will affect all these cells.

Paintbrush
Line mode: Use the paintbrush in Line mode to draw new lines. This brush is
not accumulative while dragging. That means, that unless you lift the mouse
button, the brush color will not step on itself and will paint in a constant color.
To add new lines to a drawing simply set the brush size to a very small value
(2 to 5), set the softness value very high (50 to 100), and transparency to about
50. This will give you a soft brush to close those nasty gaps.

Fill mode: It is used the same as in the Line mode, but modifying the fill layer.

Line + Fill mode: It will modify the fill layer while showing the line layer.

Airbrush
Line mode: The airbrush has a special use in Line mode. With it you can
change the color of the lines by painting over them. The shape of the line will
not be changed, only the color.

Fill mode: In this mode the airbrush will paint like the paintbrush, but with
accumulative colors. That means that while dragging the mouse, if the brush
steps over its track, it will make the color more opaque every time. To use the
airbrush to its fullest, always choose very transparent brushes.

Line + Fill mode: As with other tools, on this mode the airbrush will have the
same effect as in the Fill mode, but showing the line layer.
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Colorbrush
The Color Brush lets you paint over painted areas only. You can paint on an
already-colored line, or paint over an already-colored fill area.

To paint over an already-colored line, do the following:

1. Select the Show Line mode. If you also want to see the color layer while
you paint, select Line and Color mode also.

2. Drag your mouse over the line and start painting. 

To paint over an already-colored fill area, do the following:

1. Select the Show Color mode. If you also want to see the line layer while
you paint, select Show Line and Color mode also. 

2. Drag your mouse over the colored area and start painting. Notice that the
color is only applied on areas that are already painted, keeping the transparent
areas uncolored.

Line
Line mode: Draws lines on the line layer.

Fill mode: Draws lines on the fill layer.

Line + Fill mode: Draws lines on the fill layer while showing the line layer
as well.

Drag image
This tool is used whenever you are compositing large background images.
During that process, whenever you compose and image over another, you
may need to zoom in. If you select the zoom tool, you will loose the ability to
move the new image to finalize your composition. Click on this tool to be able
to move the new image once again.

While using any of the paint tools specified above, pressing the CAPS LOCK
key, the cursor image will change to a cross-hair for improved tool accuracy.
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10.4 Tool options dialog

The Tools Options dialog is available in the View menu via the Show/Hide
Tools Options option. This dialog is used to modify the current drawing tool. 

The Fill and Line tools are particularly affected by that dialog. It is possible
to modify the tool type by choosing one of the available tool choices in the
drop down menu. For example, gradient fill modes can be selected in the drop
down menu; new line tool types can also be selected from the drop down
menu (line, rectangle, ellipses).

10.4.1 Gradient fills 
Two fill modes are added to the Fill tool: Cartesian and Radial gradient
fills. The user can use the Tools Options dialog to choose which gradient fill
mode to use. The Fill tool still works as before, but using the ALT key while
clicking on the region to paint will perform a gradient fill. 

Gradients are defined by the foreground and background colors that are
available in the Paint area of CTP; it is therefore a 2-color gradient. 

When using the Cartesian fill mode, the user
can define the angle of the fill by dragging
the mouse button with the ALT key still
pressed. When the mouse button is released,
the fill is performed. 

When using the Radial fill mode, the user
can define the center of the fill by clicking on
a precise point in the region to fill. The radial
fill is performed inside the rectangular region
defined by the actual region to fill.
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10.4.2  Textured fills 
The Tools Options dialog offers another fill mode called Textured Fill. This
mode lets the user fill a specific area with a specified texture file. To use the
Textured fill mode, select the Fill tool, then select the Textured Fill mode in
the Tools Options dialog, click on the Browse button to select an image file
(any image file type that is normally recognized by CTP can be selected as a
texture), and finally, use the ALT key while clicking in the desired region to
be filled. The texture is centered at the mouse location when the button is
clicked.

Note: The texture filename and its size are
written in the Tools Options dialog. An
additional feature called Repeat Texture is
available when Textured Fill is selected.
When activated, this feature repeats the
texture if the whole texture has been used in
the fill algorithm (i.e. when the region to fill
is bigger than the texture itself). 

Another new feature called Use first pixel
for overflow can be used whenever the
texture is not repeated. When activated,
overflow pixels are set to the first pixel of
the texture (at (0,0)) instead of repeating the
first/last available pixel of the current
scanline from the texture. 

Alpha channel information is preserved when using a partially transparent
texture, as all color/alpha channels are used by the fill algorithm.
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10.5 Customizing the user palette

To modify any of the user palette color boxes simply follow this three steps:

1. Select the color box you want to modify.
2. Choose a color for this color box with any of the methods described above.
3. Double click on the current color box. The previously selected user palette

box should now contain the desired color.

As a complement to color models (which will be explained in the next
chapter), when using the same set of colors repeatedly to fill in your line
images, you can speed up the color selection process by setting up as follows:

1.  Customize your color palette as described above.

2.  If the colors to be used are next to each other, place the mouse cursor right
before the leftmost color you want to select until a hand tool appears on-
screen.  Press the Shift key while pressing the left mouse button.  Drag the
mouse to the right of the last color to be selected, making sure the
displayed selection box completely covers the needed colors, and release
it.  Notice that the selected colors have been marked with a check mark.
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3. If the colors to be used are not close to each other, you can select them
individually. To do so, press the Shift key and the left mouse button at the
same time while the mouse pointer is over the desired color(s).

4. Once the colors have been selected, use the Q and W keys of your
computer to select the actual color from within the established range. Use
the Q key to move the selection from right to left. Use the W key to go
from left to right. Whenever the selection reaches the left or rightmost
edges it will cycle to the upper or lower palette colors.

5. Deselecting any of the selected colors is carried out in the same way as
when selecting them, but instead of creating your selection box from left
to right you should create them from right to left. To deselect them
individually follow the same process as in step 3.

10.6 Standardized Color Palettes

Color palettes are often used by artists to get constant color values in the ink
& paint process of cel animation. CTP has always supported color models
through the use of user definable color palettes, the so-called Color Model
Archives (CMA, see chapter 11).

In addition to user definable color palettes, the CTP Pro HD, CTP Pro SD and
CTP Paint versions now also support a series of pre-defined and widely
standardized color palettes, such as RGB or RAL.

The Classic RAL System is used for defining standard colors for paint and
coatings. RAL is the most popular Central European Color Standard today.
The colors are a standard used in architecture, construction, or industry. CTP,
being able to access these color definitions, will make this new functionality
a good choice e.g. for industrial movies.

The standardized color palettes put all colors of a single palette in an easy to
use scrollable window, providing all the necessary information to select a
color from its name, number, HEX value or its appearance.
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RGB or RAL colors are often referenced by their name or number or specific
value. It is therefore possible to switch between color name, color number and
its HEX value.

The interface is following the CTP standards: included in the main (and only)
window, it is resizable (with a minimum size to avoid loss of information) and
scrollable. Since the color names are important, they are sorted in a list (from
left to right in the color bar) as opposed to palettes which are displayed as a
matrix. You can access the colors using the following interface:

The cursor always reflects the current color selection and will stay in the
center, if possible (when reaching either end of the color spectrum, the cursor
can freely go left/right). In our example, it is left from the center; this is
because the user reached the left side of the color bar. In this case the left
arrow control will be disabled, meaning that there are no colors beyond the
leftmost color.

Each time a new color is selected using the left mouse button, the Current
Color value changes. The Alternative Color changes when the selection is
made using the right mouse button. You can either select a color by moving
the cursor left/right, by directly clicking on a color or by using the left/right
arrows on the scroller. The Current selection always represents the current
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color under the cursor, while any of the mouse buttons is clicked. Clicking on
a color name in one of the three color boxes (Current selection, Current color,
Alternate color), will move the cursor to that color in the color bar.

It is also possible to access a specific color by entering its name, number or
HEX value into any of the three color boxes (Current selection, Current color,
Alternate color) and hit RETURN on your keyboard.

The Color Picker can be used on any of the color boxes (Current selection,
Current color, and Alternate color). Once the color is picked from the Palette
Browser interface, the corresponding color is selected in the Paint interface
(at the bottom of the CTP screen).

10.6.1 Loading the color palettes

There are two different standardized color palettes: RGB and RAL. These
palettes contain different color values and you can select either the one or the
other. There will only be one standardized color palette loaded at a time.
Loading will be performed by one of the following actions:

1. Adding a toolbar in the View > Toolbars option:

The Palette Browser toolbar displays three buttons: RGB, RAL1 and RAL2.
All buttons are mutually exclusive, meaning that only one can be selected at
a time.
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Here is the toolbar:

2.  Activating one of the View > Palette Browser [RGB, RAL1, RAL2]
option. When activated, the Palette Browser interface is shown and contains
the corresponding colors. Choosing a palette is also a mutually exclusive
process; only one can be selected at a time, so the menu options behave like
radio buttons. 

3. Alternatively you can also use the shortcuts ALT+1 through ALT+5 to
activate the corresponding Color Palette. This will work with or without
loaded Palette Browser Toolbar.
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The Palette Browser interface can be unloaded (removed) by either
unselecting the current palette in the Palette Browser toolbar, or selecting the
View  Palette Browser  [RGB, RAL1, RAL2] option again, or use the
shortcuts ALT+1 through ALT+5 to deactivate the corresponding Color
Palette.

These actions will remove the Palette Browser interface from the CTP screen
and will resize/move the remaining parts of the screen accordingly.

10.6 Accepting your painting

When you have finished painting the image, press the ok! button to accept the
changes, or the no! button to cancel them. Remember that if you select
another cell without having pressed one of these buttons, the changes will be
accepted automatically as if the ok! button were pressed. If you only want to
go back one step use the undo button command or press CTRL + Z, which
will only undo your last paint operation. Press it again to redo this operation.
Press the ESC key to cancel all made changes.
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11. Color Models  

Color models are used as an easy and accurate way to ink & paint animations.
These are usually setup at the start of an animation project so that every ink
& paint operator can choose the proper colors easily. Within CTP, the Color
Models are saved in Color Model Archives (CMA). These archives can
contain as many color models as required and can be easily edited by means
of the standard exposure sheet. Once created, the color models have no direct
link with any scene. They can be opened for use as a reference while editing
any scene.

11.1. Creating Color Models

To create a new Color Model Archive (CMA) choose the New CMA option
under the File menu or on the CMA toolbar. A dialog will appear showing the
available archives. Write down the name of the new archive making sure it is
different from any of the already existing ones. Once created, it will appear at
the lower right area of the screen, right below the exposure and storage sheets.

Color Model Archives can only be edited or used while working with a scene.
That means you must open a scene even if you only want to modify a CMA.
After editing the CMA you can discard the scene data, the CMA's data is
totally independent of the scene used to create it.

Once a CMA is created, it can be opened at any time while editing a scene by
using the Open CMA menu option under the File menu or on the CMA
toolbar. Select the needed archive from the displayed list of available CMAs
and press the OK button.

While working with color models on a network, only one operator will be
allowed to open the color model to modify it. If someone else tries to open
the same color model, he will not be allowed to modify any of its data, just
pick colors from it.
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11.2. Editing Color Models

All images included in any color model have its origin either in the storage
sheet or in the exposure sheet of a scene. If you have imported an already
colored image, you can directly drag and drop it into the color model list.  You
can edit the future color model as a regular drawing or full color image on the
exposure sheet as you would do with any other drawing or image.  Once the
image has been processed and colored, follow the same procedure.  The new
color models will appear on the color model list.

In the same manner, you can drag and drop any previously processed color
model back into the exposure sheet for further editing. Whenever dragging a
color model from/to the exposure sheet you can use the CTRL key to generate
a copy of the selected cells, otherwise a move will be performed and the
original cells erased.  If the Shift key is pressed, the result will be an insert.

You can modify the names of color models once they are on the color model
list. Press the F2 key, or double click on the cell, and write the required name.
Names for sheet cells are limited in length to four characters, but color model
names have no limit. Whenever a color model is moved back to the exposure
sheet for further editing, its name will be cut down to four characters, but
without loosing the original name. Once editing has been finished and it is
brought back to the color model list, its name will be restored to its full length.

To erase any number of color models, click on the first model to erase, SHIFT
click on the last model to erase, and press the Del key. You can also select
individual models by using the CTRL+click to select or deselect any color
model. The highlighted color models will be erased whenever you press the
Del key. This operation is not recoverable, so the program will ask for your
verification before satisfying such a request.

CHAPTER 11

97Color Models



11.3. Using Color Models

Once a CMA is opened, it can be used to select colors while performing paint
operations on any exposure sheet cell. Simply move the mouse to the color
model display area and click on the desired color. Whenever the mouse cursor
is in the color model display area, it will show the classical get color icon to
indicate you are about to make a selection. When returning to the paint area,
the previously selected paint tool icon will reappear automatically.

Since color model images can be as large as required, you have several tools
to control which part of the color model you want to view. Use the Real Size
tool on the CMA toolbar to show a pixel accurate representation of the color
models. Use the Fit to Window tool on the CMA toolbar to fit the entire
toolbar in the display area. To zoom in and out on the color model, select the
zoom tool on the main toolbar.

If the color model's full size is larger than the actual display area, you can
press the spacebar at any time to drag the image around by clicking on the left
mouse button and moving the mouse. To zoom in/out the image, press the
space bar while clicking on the right mouse button and moving it up/down.

11.4. Saving CMAs

Whenever you have modified a Color Model Archive make sure to save it to
keep all the changes. If CTP or the archive is closed without saving and
changes have been made, CTP will ask you if you want to save the changes
before closing.

Due to the fact that a CMA is made up of various files, the most practical way
to remove them once they are no longer necessary, is by means of CTP. Use
the command Remove CMA on the File menu to delete CMAs you no longer
need.

The CMAs are made up of a group of specific images and files of CTP. These
files are stored in one single folder with the actual name of each CMA. If you
wish to transfer a CMA to a removable storage device, such as a USB stick,
to distribute it amongst your animators, you only have to copy the required
CMA folder to that media.
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12. Image processing

Image processing are processes that affect the totality of an image although it
will take into account whatever mode you are in: line, color, or line + color.
These image operations can be used to produce certain effects, or to finish
adjusting the images visually.

12.1. Operations

To carry out certain general changes on a cell or selection of cells we have the
following operations:

·  Brightness: Adjusts the intensity of the image. The greater the brightness,
the greater is the intensity of the image.

·  Contrast: Adjusts the contrast between the dark and light tones of the
image. The greater the contrast, the larger the difference between these tones.

·  Color correct: This operation allows you to adjust the level of each color
component of the image. The positive values will intensify the color
component, where as the negative values will decrease intensity.

·  Blur: This operation will blur the entire image to make all outlines
smoother.

·  Opacity: This operation will establish the new global opacity values of the
image.  
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These operations affect the entire range of selected cells.  To use any of these,
first select the cells that you want to modify, and then carry out the
corresponding modifications. Remember, that they will only affect the image
layers shown by the actual display mode.

1. Select the range of cells to be modified. Only the first cell selected will be
displayed on screen.

2. Press the button on that corresponds to the operation to be carried out.  The
screen will display the first of the selected cells already processed with the
selected effect. Use this cell as a reference of what will occur with the rest of
the selected cells.

3. Adjust the parameter(s) of the selected effect until the desired results are
obtained. 

4. If the results are correct, press ok!, and this operation will be carried out
over all the selected cells. If not, press no! and it will be canceled.

Press the Flip Horizontally button to horizontally invert all images of the
selected cells.

Press the Flip Vertically button to vertically invert all images of the selected
cells. 

Use the Color Replace button to replace a color on a selected range of cells.
Firstly, pick the color you want to replace using any of the available tools.  It
will be set into the current color box.  Now select the new color with which
you want to replace it.  Now this new color will be set as the current color,
and the first color will now appear on the previous color box. With this setup,
now press the Color Replace button. The change will immediately show for
the actual cell. Press the Ok! button to accept the operation or the no! to
cancel it.

Note:  Remember to activate the desired layers before carrying out multiple
operations.
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12.2. Image menu

The Image menu extends the previously described image processing with a
great selection of tools for color processing, special effects and filters.They
can be used, to change the appearance of one cell or a sequence of cells or
backgrounds. 

In order to use the effects, the user must select at least one
image cell (a single image, or a painted or unpainted cell).

Note: You can select more than one cell, and apply any kind of effect to them
(except Unique Colors) but there is no Undo on a multiple cell operation.

Important: Some special effects (Mosaic, Average Blur and Median Blur for
example) work better on backgrounds or fully-colored images; applying those
effects on line art will give strange results since the effect is applied on lines
and color regions separately (line art layers and color art layers are treated
separately and within the boundaries of the alpha channel/mask layer), not the
whole rendered image.

Here is a description of each effect: 

Color effects
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Color > Invert...
Inverts the colors in the selected image(s), like a photographic negative.

Color > Brightness…

Changes the intensity
(brightness) of the selected
image(s). The intensity ranges
from -1000 to +1000.

Color > Contrast…

Increases or decreases the contrast of the selected image(s). Valid values are
from -1000 to +1000.

Color > Hue…

Changes the hue in the selected image(s) by rotating the color wheel.

Color > Saturation…

Increases or decreases the saturation of colors in the selected image(s). Values
are between -1000 and +1000.

Color > Stretch Intensity

Increases the contrast in an image by centering, maximizing, and
proportionally increasing the range of intensity values.

Unlike the Contrast effect, this image effect always retains the original
number of different intensity values (ordinary contrast adjustments can loose
value at the high and low ends of the scale).
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Color > Gamma Correct…

Adjusts the intensity of colors in the selected image(s) by changing the
gamma constant that is used to map the intensity values.

Intensity values ideally follow a logarithmic progression, because the eye
perceives changes in intensity as being equal when the ratio of change is
equal. For example, we would see a change from 0.1 to 0.2 as being equal to
a change from 0.2 to 0.4. Gamma is a standard constant that is used to
calculate the progression. For most computer monitors the gamma constant is
in the range of 2.2 to 2.5.

Color > Intensity Detect…

Filters the selected image(s) to detect colors in a specified intensity range.
Intensity levels range from 0 to 255 for each color plane (red, green, and
blue). This image effect processes each plane separately. If a value falls
within the range, it is raised to 255, and if it falls outside the range, it is
lowered to 0. 

Color > HistoContrast…

Increases or decreases the contrast of the selected image(s), using a histogram
to determine the median brightness.

Valid values are -1000 to +1000.

This image effect finds the median brightness of the image; then brightens the
pixels that have values above the median and darkens the pixels that have
values below the median. 

Color > Solarize…

Applies an effect that mimics the accidental exposure of photographic film to
light. It does so by inverting all color data with an intensity value greater than
or equal to the threshold that you specify.

The valid range is 0-255.
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Color > Unique Colors…

Gets the number of unique colors in an image. This image effect treats line art
and color art planes separately (the function will return two different values
for drawing cells).

Note: This image effect CANNOT be applied to a multiple cell selection.

Flip

Flips the selected image(s) from top to bottom.

Reverse

Reverses the selected image(s) left to right to produce a mirror image.

Special effects

Effects > Posterize…

Imposes a poster effect on the selected image(s) by reducing the number of
colors in the image(s) to a specified number of color levels per plane. For
example, two levels means two of red, two of green, and two of blue.

The user specifies the number of color levels to use. Valid values are 2
through 64.
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Effects > Mosaic…

Imposes a mosaic effect by dividing the selected image(s) into tiles of a
specified size and changing the color of all pixels in each tile to the average
color of the pixels within the tile.

Note: The effect is applied within the image's alpha channel (i.e. mask layer),
which may give strange results on line art layers. We suggest that you try with
different images, or combine bitmap layers first, and then apply the image
effect on the result bitmap.

Effects > Average…

Changes the color of each pixel in the selected image(s) to the average color
of all the other pixels around it. This results in a blur effect.

Note: The effect is applied within the image's alpha channel (i.e. mask layer),
which may give strange results on line art layers. We suggest that you try with
different images, or combine bitmap layers first, and then apply the image
effect on the resulting image(s).

Effects > Median…

Changes the color of each pixel in the selected image(s) to the median color
of all the other pixels around it. This is similar to the Average image effect,
but it is used for noise reduction rather than a blur effect.

Note: The effect is applied within the image's alpha channel (i.e. mask layer),
which may give strange results on line art layers. We suggest that you try with
different images, or combine bitmap layers first, and then apply the image
effect on the resulting image(s).
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Effects > Sharpen…

Increases or decreases the sharpness of the image in the selected image(s).

Valid values range from -1000 to +1000.

Negative values decrease the sharpness of the image. Specify -1000 for
minimum sharpness. Positive values increase the sharpness. Specify +1000
for maximum sharpness.

Effects > Add Noise…

Adds random pixels to the selected image(s), letting you specify the
percentage of coverage and the color plane. You choose the percentage of
coverage. It is expressed in tenths of a percent. Valid values are 0 to 1000.

Effects > Emboss…

Applies a three-dimensional
embossing effect to the
selected image(s), letting you
specify the depth and
direction of the effect. 

Effects > Edge Enhance

Detects and brightens edges in the selected image(s). This effect might be
used to outline edges of a drawing, to mimic a pencil drawn line. 

Effects > Oilify…

Creates an effect of broad brush strokes on the selected image(s), to look like
an oil painting on a canvas.
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Spatial filters

A spatial filter recomputes the
brightness of each pixel in the
selected image(s) by using a
weighted averaging technique
that considers the surrounding
pixels.  

Spatial Filter > Gradient…
The Gradient filter detects edges using a Gradient directional filter. All pixels
that are not on the detected edges are changed to black.

Spatial Filter > Laplacian…

The Laplacian filter applies Laplacian line detection. There are three omni-
directional filters and three bi-directional ones. All pixels not on the detected
lines are changed to black.

Spatial Filter > Sobel…

This filter applies Sobel edge detection. All pixels not on the detected edges
are changed to black. The usage is the same as the Prewitt image effect, but
the algorithm (mathematics used to compute the effect) is different.

Spatial Filter > Prewitt…

This filter applies Prewitt edge detection. All pixels not on the detected edges
are changed to black. The usage is the same as the Sobel image effect, but the
algorithm (mathematics used to compute the effect) is different.
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Spatial Filter > Shift and Difference…

This effect applies shift-and-difference edge detection. All pixels not on the
detected edges are changed to black. 

Spatial Filter > Line Segment…

This effect applies line segment line detection. You can use this filter to find
line discontinuities in an image. All pixels not on the detected line segments
are changed to black.
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13. Camera movements

CTP has been designed to support any number of camera layers. Each camera
layer must be assigned to at least one animation layer. Every camera layer will
affect all the animation layers to its left up to the next camera layer.  A special
case to this rule is the global camera which is displayed at the end of the
exposure sheet in a darker green color and affects the entire exposure sheet.

13.1. Field Chart

If the field chart button is pressed, the screen will display a classical field
chart, showing the present registration of the image. Everything that appears
within the field chart is what will appear when making a playback render of
the animation. This field chart is simply a reference, and you can work
normally, both if it is activated as well as deactivated.

13.2. Camera layers

Selecting a cell of one of the camera layers activates the motion area on the
main toolbar. The screen will display only the drawings or images belonging
to the cells of the active layers affected by the camera layer in question.
Remember to activate the layers you wish to view.

You can modify each parameter of the animation interacting with the image
directly on screen, by modifying the parameter on the motion area, or by
modifying the animation curve.

To carry out a camera movement between certain amount of frames, just edit
the parameters of the first and last frames. The system will automatically
calculate the required camera movement values for all the selected cells to
guarantee a smooth transition.

Camera layers can also be flattened together with their image layers in order
to modify their original size or input position, freeing up that camera layer to
create compound animations.
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By pressing the Low and High buttons, you can vary the on-screen preview
quality. This quality option does not affect, in any way, the final playback
render quality option found in the general options panel of the program.

13.3. Pan

With the pan operation, you can place the camera horizontally and vertically.
The movement is measured in pixel units. Selecting X or Y Pan will only
select which animation curve will be displayed. You can always modify both
values interactively on-screen selecting either button.

13.4. Zoom

Place the cursor over the area you want to zoom and drag the mouse to move
the image closer to or further away from the camera. By dragging your mouse
upwards, you get the camera closer (a larger image), and downwards to move
it further away (a smaller image). While zooming, the location over which the
mouse was set initially is always kept fixed on-screen, that area will be the
center of the operation.

The units used to measure the zoom are in percentages. 100% is the original
size of the image, 200% is twice as large, and so on. If you have intentions of
carrying out very deep zooms of over 200%, it is advisable to scan the images
at a higher resolution to obtain maximum quality. The maximum allowed
zoom size is of 400%.

13.5. Rotate

With the rotate operation you can rotate the camera around its axis. Move
your mouse around the rotational axis both clockwise (negative angle) as well
as counter clockwise (positive angle) to modify its value interactively. The
rotation is measured  in degrees. Pressing the SHIFT key while rotating will
use increments of 15 degrees.
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13.6. Blur  

You can animate a Blur using the camera. This is great for creating multi
plane effects, such as a rack focus.

13.7. Opacity  

You can animate the Opacity (transparency) using the camera. This is great
for creating transitions between scenes (fade-ins and fade-outs).  

If you wish to work with field measurements rather than pixels, activate the
fields button.  

13.8. The camera curve area

The camera curve area is designed to help you create very accurate and
smooth animations.

The camera graph is where we will set all our keyframes, which indicate the
camera positions throughout the animation. The graph’s horizontal axis will
display your position in time, the frame numbers. On the other hand, the
graph’s vertical axis will display the range of values for the actual parameter
you are modifying. Select any of the available parameters to display and
modify its keyframe graph. 

You can work directly on the camera graph to add and remove keyframes,
change their position, zoom in/out, use a hand tool to be able to move along
the whole graph, or control the keyframe tension points.
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·  Adding keyframes: move the mouse to the point where you want to make
the addition. Hold the CTRL key and click on the left mouse button.
Whenever you add a keyframe for any of the available parameters, the
program will automatically add keyframes for all the other parameters at their
actual values to make sure you get consistent camera animation.

· Removing keyframes: move the mouse to the keyframe you want to
remove.  Then, proceed in the same way as when adding keyframes, this is,
holding the CTRL key and clicking on the left mouse button.

· Changing keyframe’s position: drag the mouse to the keyframe you want
to change its position and click on it.  Notice a vertical white line crossing the
selected keyframe which means you are actually displaying this frame. To
change the keyframe’s position, keep the left mouse button pressed down and
drag it along the vertical axis. If you look at the visualization area while doing
this operation, you will see the image changing its position. You will see, as
well, the keyframe moving upwards or downwards, depending upon which
direction you are dragging your mouse.  Release the left mouse button to drop
the keyframe at the desired value.

·  Zoom in/Out: To zoom the graph, move your mouse over it and, while
holding the right mouse button and the space bar from your keyboard, move
the mouse on the following directions:

. To the right  Stretches the graph horizontally.

. To the left    Squashes the graph horizontally.   

. Upwards      Stretches the graph vertically.

. Downwards Squashes the graph vertically.

·  Hand tool: In a large scene, you will notice that some keyframes are not
shown on the graph at the same time due to the graph’s scale.  To be able to
move along the whole graph, move your mouse inside of it, and, while
holding the left mouse button and the space bar from your keyboard, move the
mouse to the left or right along its full length.
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·  Keyframe tension points: The keyframe tension points are located at both
sides of each keyframe. These two points are used to control the smoothness
of the curve between two keyframes. The left tension point will affect the
curve between its own keyframe and the one to its  left. Therefore, the right
tension point will affect the curve between its own keyframe and the one to
its right.  Notice that the tension points will not allow you to move them over
any other keyframe. To move each tension point, click on the point you want
to move and, while holding the button, move the mouse in any desired
direction.

If you wish to move keyframes in time from one frame to another, press the
SHIFT key and, while holding on the left mouse button, drag the keyframe to
the desired position. Release the left mouse button to drop it. When a
keyframe is being moved, it cannot be moved further than any of the
surrounding keyframes.

If you wish to level both keyframe tension points horizontally, press the
SHIFT key and drag one of the tension points.

Keyframe tension points
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14. Transfer

Once the editing of the scene is finished, it should be transferred to video,
either for checking or for broadcasting. To accomplish this, it is as simple as
doing a playback as explained in the section on editing the scene, but with
certain particularities.

14.1. Transfer to video

To transfer to video through the video I/O board on your computer, simply
activate the video transfer button. With this option activated, any playback
operation carried out will always go through the video board. Depending on
the characteristics of your video board, it may also appear on screen.

So that the output quality may be optimum when using this method, setup
your computer carefully following the suggestions of the video board
manufacturer. CTP supports all Video for Windows compatible video boards.
Choose the video board with the appropriate input/output quality for your job. 

The information stored in the CTP files is always broadcast quality, but the
video output quality depends totally on your video board.

14.2. Exporting image and video files

To export images, select Export Frames from the File menu.  The following
window will be displayed:

1.  Enter the First and Last frame
numbers to export. If you have previously
selected a range of frames, these will be
automatically  entered.  By default it will
always show the first and last animation
frames.  

2.  Enter the step desired.  A value of two
will export every two frames, a value of
three every three, and so on successively.

In this way, you can avoid exporting repeated frames. To export a single
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frame, deactivate the Sequence option.

3.  Press the Browse button located at the right of the directory box.  Enter
the name of the file to be saved and press Save.

4.  On the Format drop down list select the preferred export image format.
To export frames as a movie select either AVI Movie, Flash Movie or
Quicktime Movie.  Any of these options will export the whole animation as
a single file. If you want to export frames as sequence of individual images,
select the corresponding image format from the list.

5.  At the Name box will be displayed the name given to the file.  If an image
format has been selected from the Format list, the selected name will contain
the “#” symbol. Use this symbol to place where you want the file sequence
number to appear in the filename. For example, if the filename is Villy the
Devil.JPG, the file sequence will be Villy the Devil.1.JPG, Villy the
Devil.2.JPG, etc.   

6.  Next to the Name box you will find another First and Last entry boxes.
The First box will automatically display the number entered at the previous
First box located at the Frame Sequence section. The Last box will vary
depending upon the number of frame repetitions entered on the Repeat field.
By default, the repeat factor will be the same as the one selected from the
Options window (Tools menu > Options > Player tab). The Repeat factor
goes from 0 to 100.

7. Enter the number of digits format you want to use for the filenames. The
maximum value is 5 digits. This value sets the size in digits given to each file
sequence number. If the sequence number is not large enough to fill this
amount of digits it will be filled in with zeros. An example will be displayed.
Activate the Export Alpha Channel option when required.

8.  Enter the Width and Height for the selected frames. Keep the aspect
ratio activated if you want to automatically maintain the same rational ratio
you use on your scene.

9.  Press OK.
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14.2.1.  Adobe Flash

CTP lets you export film clips in Adobe's flash file format (sometimes called
SWF, pronounced 'swiff'). The flash file format is currently the standard for
delivering animation on the Web. Graphics viewed on the Web need to be as
small in file size as possible in order to reduce the time it takes to download
and view a Web page.

The Flash format saves graphics using vector data, simple coordinates and
colors, using a very small amount of data. It also uses traditional bitmap data
when appropriate. Since CTP normally saves the frames of an animation as a
series of bitmapped images, it also lets you assemble these images into a flash
animation. The result is an .swf file that can be put on a website, and easily
displayed on any Web browser.  

To export a Flash file, do the following:
1. In the File menu in CTP, choose Export Frames. 
2. In the dialog that appears, click on the Format drop-down menu, and  

choose Flash Movie. 
3. Enter any other parameters for your file, for example the frames to be  

included in the clip and the name for the movie. 
4. Click OK. A second dialog will appear, named Flash Movie Compression.  

Here you can choose if you want to compress the file to minimize its file  
size. You can also select if you want the movie to loop continually when it 
is replayed. If you do want compression, you must choose a level for both 
the image quality and the sound quality.

Note: Moving the sliders to the left reduces compression, producing higher
quality images and sound, but increasing the size of the resulting file. In the
same idea, putting the compression to maximum will produce a very small
file that will load quickly over the Internet, but will be of limited quality.

Once the Flash movie is displayed on a Web browser, such as Mozilla Firefox
or Internet Explorer, you can zoom into, or magnify the movie from a pop-up
menu that appears when you right-click on the movie. 
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14.2.2. Determining the image quality

CTP will export images using a variable image quality factor. In the Export
Frames dialog, it is now possible to specify the quality factor with a slider.
The slider offers quality factors ranging from 2 (Maximum quality, no loss)
to 255 (Minimum quality, full compression).

Please note that some file formats do not use the quality factor (PNG for
example, always uses the best factor available - 2, that is) while other formats
might use their own factor (all movie formats, for example).

14.2.3. 3:2 Pulldown

CTP can now export frames using a special method that converts 24
images/sec into 30 images/sec. It uses 24 images that were created in CTP
using a 24 images/sec film scene and generates 30 video images that meet
NTSC video timing requirements. This process is called a 3:2 Pulldown. The
process currently allows to transfer a 24 img/s scene (film sequence) to a 30
img/s scene (NTSC video sequence) directly in CTP, without having to use a
Telecine or any 3rd party program.

How does it work?

“Film” is shot at 24 frames per second (fps), but NTSC television signals run
at 30 fps. As a result, it is necessary to convert the 24 distinct frames in a
second of film into 30 frames that can be played back on television; if you
were to ignore this different frame rate and attempt to play back your film
material at a 1:1 ratio with video frames, your material would play back at
125% of the actual speed. A one minute film clip would playback in 48
seconds!  Please note, that only NTSC video contains this 3:2 pattern, as PAL
video runs at 25 fps and contains an altogether different pattern to solve the
problem (24:1 pulldown).

During “Telecine” (also known as film-to-tape transfer) when film material is
transferred to video, a 3:2 pulldown sequence is introduced into the footage
which mixes alternating combinations of 3 and 2 video fields.  This sequence
essentially stretches the 24 frames in a second of film into 30 frames, so that
when they are played back as video, they transpire in the same 1 second that
they would have on film.
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Why does 3:2 pulldown work?  

Because there are 2 fields per frame of NTSC (two fields constitute one
frame: even scan lines make an even field, while odd scan lines make the odd
field) which adds up to 60 fields in a second.  Since 24 and 60 have a common
denominator of 12, then 2*12=24 and 3*12=36. Thus, by mixing 2 and 3
patterns of fields (24+36), we get to 60 fields in a second.

Let's consider how these frames of film get mapped into fields of video. If the
first frame of film is taken and placed on 2 fields of video, then the next frame
is taken and placed on 3 fields, then 2, then 3 (and so on...), the result is that
every 4 frames of film will land on every 5 frames of video (24/6=4 frames
at film rate, 30/6=5 frames at video rate).

This pattern of video frames is what we call 3:2 pulldown. It is a repeating
sequence with five variations, although by looking at the various languages
and methods used by software/hardware tools that insert and remove this
pattern, you would think there were 100 flavors. 

To perform this kind of conversion, open the Export Frames Option in the
File menu. 

The following dialog box will appear:

Here you can set all export parameters. When
done, click on the 3:2 Pulldown button. 
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The following dialog box will appear:

You have the choice between 3 different preset
pattern, which are the most common in video
and post production.

- Telecine for NTSC Video: this pattern generates 5 frames from 4 incoming
frames (remember the 4 frames-in-5 frames transformation) using mixed
fields for the 2nd and 3rd frame. Here is the pattern:

Frame 1: A1-A2
Frame 2: A1-B2
Frame 3: B1-C2
Frame 4: C1-C2
Frame 5: D1-D2

Where A1 means "Image A, Even field", B2 means "Image B, Odd field" and
so on. The input film images have been named A through D to avoid mixing
output and input frames.

- Avid Film Composer: this pattern comes from the popular editing tool of
the same name and uses the following setup:

Frame 1: A1-A2
Frame 2: B1-B2
Frame 3: B1-C2
Frame 4: C1-C2
Frame 5: D1-D2
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- Habware's 24to30fps: Habware's 24to30fps: this pattern is taken after a
shareware application that uses the following setup:

Frame 1: A1-A2
Frame 2: B1-A2
Frame 3: C1-B2
Frame 4: C1-C2
Frame 5: D1-D2

- Customized pattern: this pattern is determined by the user. When this
option is selected, Fields buttons can be clicked repeatedly to alternate
between field values that are used for each of the 5 output frames.

Note: the 3:2 Pulldown can be cancelled anytime by clicking on the Cancel
button.

Limitations

1.) Sound:

CTP is not able to perform a 3:2 Pulldown on the sound layers. The sound can
instead be stretched and saved separately, and mixed later using CTP or a 3rd
party editing software.

2.) 2:3 Pulldown and 24:1 Pulldown:

CTP can transfer 24 to 30 frames per second, but can't do the opposite. It is
also impossible to transfer a scene from 24 frames per second to 25 frames
per second (PAL video system).
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14.3. Exporting sound

To export sound select Export Sound from the File menu. The following
window will be displayed:

1.  Press the Save As button and enter the name of the sound archive.

2.  Select the sound format at the Format drop down list.

3.  Select the sound frequency at the Attributes drop down list. The higher the
frequency selected, the more memory will be required, but the better the
output quality will be.

4.  Press OK. 

14.4. Sharing scenes with removable storage devices

Each Scene or Color Model Archive stored by CTP is saved integrally in its
own folder, and these document folders are stored within a general folder
selected for this purpose in the general program options. To share data, simply
copy the folder with the name of the required Scene or CMA onto a
removable magnetic support (USB Stick, CD/DVD-ROM, USB hard disk,
etc.), or onto another folder on the network. All information on a Scene or
CMA is in its own folder, and whoever receives it will have an integral copy
of this document. You can also open the scene with CTP and use the Save As
option to save it on any other disk.
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14.5. Printing sheets and images

If you want to print out the Storage Sheet, the Exposure Sheet, the actual
display area or the reference Color Model, press the Print button or select the
Print command on the File menu. Select what you want to print in the
selection window and press OK.

14.6. Networking

Due to the simple file management on which CTP is based, networking is
extremely simple. Whether it is a local network, through Internet or with the
use of removable devices, it is extremely easy to share jobs with various
operators.

Nevertheless, and due to the complex changes carried out by CTP on the
archives of the opened documents, you can never have more than one person
working on the same Scene.  
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15.  Options Setup

In CTP there are many useful setting options which allow you to configure
and preset CTP for your own purposes. All available parameters are available
on several Options tabs, which you will find in the Tools menu.

These parameters have reasonable default values set during installation, but
you can customize and save them to your liking at any time.

General tab

Contains the global options of the program, which affect all documents
carried out with it.

· Show startup dialog: Activate this option if you want to view the initial
dialog to open or create documents each time you start up the application.

· Reload last opened plan at startup: Activate this option if you want
the program to automatically open the last scene you were working on.

· Unused files option: Activate this option to automatically remove all
unused files inside the CTP scene folders.

· Language: Select the desired language, the user interface and the
integrated help system should appear, and restart CTP.
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Player tab

With these options you can define the output characteristics when playing
back an animation. The CTP Player is responsible for the playback in the
preview window and the video output, should you have a video output
interface installed in your computer.

It is very important to format these parameters carefully so as to obtain the
best possible quality.

· Video compressor: Compressor to be used for the video output by the
video I/O card of your computer. By pressing the Browse button of this
section you can view a list of available compressors. Locate the name of your
video card on this list and select it. Choose Full Frames (uncompressed) if
you wish to switch compression off.

· AVI compressor: Compressor to be used for visualizing the animation on
screen from a disk. The same as in the previous case, press the Browse button
to view the list of compressors. It is recommended to select the Cinepak
compressor due to its good quality/performance ratio. However you may also
want to check the other options. Choose Full Frames (uncompressed), if
you wish to switch compression off.

· From memory: Activate this option to visualize the animations from the
memory (which is the faster method), whenever possible and provided you
have enough RAM installed in your computer.
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The Statusbar to the lower right shows the RAM capacity, the current CTP
process is using. Each CTP process can have up to 2 GB (Gigabyte) -
provided, your computer is equipped with enough RAM. Please also keep in
mind, that the Windows operating system will need some of the available
RAM, as well as other applications, which you are running at the same time.

High resolution CTP projects will consume more RAM than low resolution
projects. 

With the following parameters you can affect the maximum size of the
temporary preview video. This allows you to conserve RAM and space on
your hard drive. These settings are temporary and will not affect the real
resolution of your animation project.

· Max. size: The maximum permitted size, in percentage, during a playback
from memory. Adjust this value in accordance with the performance of your
video card and the amount of available memory.

· Min. size: The minimum permitted size, in percentage, during a playback
from memory. In the case of not having enough memory to visualize in this
minimum size, the playback will be carried out from disk with the
compression format previously selected.

· From disk: Activate this option to force the visualization of the animations
always to be carried out from disk, creating a temporary AVI file. This is less
efficient, but does not require such a large amount of memory.

· Size: Size established for animations from disk. Keep in mind that this type
of playback is less efficient than the one from memory.

· Loop: Activate this option to have the loop button of the video controls
repeat the animation from start to finish each time.

· Swing: Activate this option to have the loop button of the video controls
repeat the animation from start to finish, and backwards, each time.
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· Low: Activate this option to set to low quality the animation playback
render.

· High: Activate this option to set to high quality the animation render.

· Repetition factor: This is the number of times each frame is repeated
when playing an animation. Use this option only if your animation must have
constant repetitions. If not, set it to 1 and use the cells repetition features.

Sheet Settings tab

· Delete contents: Activate this option if,
when deleting cells selected from the
exposure sheet, you want the sheet to
remain exactly the way it was and the
deleted cells replaced by empty cells.

· Remove: Activate this option if you want
the deleted cells to be replaced by
successive cells of the same layer.  All cells
below will be moved upwards to fill in the
empty spaces.

· Insert: Activate this option if, when dragging a group of cells over another,
you want to insert it where the cursor is located, moving the current one so as
to fit the new ones in.

· Replace: Activate this option if, when dragging a group of cells over
another, you want the new ones to replace the current ones.

These two later options can be interchanged if, while dragging the cells, the
SHIFT key is pressed.
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Grid Options
CTP supports variable sizes for rows on the Exposure Sheet and variable font
size on Exposure Sheet and Storage Sheet. 

Activating the variable row size on the Exposure Sheet, allows you to resize
the row, making it smaller or larger. To resize, simply position your mouse
cursor over any grid boundary on the left side.

The mouse cursor will change its appearance. Now click and hold the left
mouse button while dragging the mouse up or down to resize the rows of your
Exposure Sheet. Release the mouse button when you are happy with the new
size of the row. All rows will be resized.

In order to change the font size on the Exposure and Storage Sheets, set the
font size to small, medium or large.

It is also possible to show the complete cell name without wordwrap, should
the length of the cell name exceed the cell width.

Last but not least, you can set the grid style to dotted, dashed or solid.

Enhanced Sheet Control
In the Enhanced Sheet Control section you can switch the mouse wheel
scroll and zoom to on or off. Additionally, it is possible to show the scroll
position while scrolling (representing the very first line displayed). Note that
both functions require a CTP restart when changed.

How to use mouse wheel scrolling and zooming on the Exposure and Storage
Sheets:

Click on any cell in either the Exposure or the Storage Sheet to activate the
sheet you would like to scroll or zoom on.
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Vertical scroll
Simply scroll your mouse wheel into the direction you would like to scroll
your Exposure or Storage sheet to. Scrolling the wheel forward will move the
vertical slider upwards, scrolling back will move the vertical slider
downwards.

Horizontal scroll
Hold the SHIFT key on your keyboard and scroll your mouse wheel into the
direction you would like to scroll your Exposure or Storage sheet to. Scrolling
the wheel forward will move the horizontal slider to the left, scrolling back
will move the horizontal slider to the right.

Zooming in and out
Hold the CTRL key on your keyboard and scroll your mouse wheel. Scrolling
the wheel forward will zoom out (for better overview of the sheet), scrolling
back will zoom in (showing more cell details). Clicking on the 1:1 button in
the upper left corner of the Exposure or Storage sheet will reset the zoom to
the default value.

Note: The default value can be determined by the value set in the Font Size
box in the Grid Options section. You can set the font size to small, medium
or large.

Reference (Onion Skinning) tab

· Reference layers: Activate this option
to display all images of the cells belonging
to the activated layers of a frame. In this
way we can work on any cell, while always
using as a reference the images of the
remaining layers of that frame.  This mode
does not take into account the animation
layer of the cell being edited.
· Lower Opacity: indicates the lower
layer’s opacity.
· Upper Opacity: indicates the upper
layer’s opacity.
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· Reference frames: Activate this option to display all images of the cells
of the actual layer. In this way we can work on any cell from the actual layer,
while always using as a reference the images of the remaining cells of that
frame. This mode does not take into account the animation layers.

· Number of Frames: number of upper frames (previous) and lower frames
(next) at the present frame which will be displayed.

· Previous Opacity: the opacity applied to the cells previous to the actual
cell. Click on the Line Color icon to select the color of the line.

· Next Opacity: the opacity applied to the cells after the actual cell. In the
same way, click on the Line Color icon to select the color of the line.

Painting tab

· Use undo buffer:  Activate this option to
enable the undo (CTRL+Z) to function.
When modifying high resolution images,
you may notice your computer to run
slower, because of the large memory usage.
Deactivating Use undo buffer will allow
you to manipulate those images a little bit
faster, although without the possibility of
using CTRL+Z to undo any unwanted
operations.

· Show alpha channel with checker board:  Activate this option to
indicate the Alpha/Transparency channel of an image as checker board. If an
image is transparent, you can now see a checkerboard background under
which it helps visualize unfilled or tranparent image areas. 
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· Deep Fill Mode:  This setting increases the sensitivity of the fill tool (the
little paint-bucket tool) in the paint commands. In other words, when this
feature is active, whenever you apply a fill color to a cell, the color will
saturate itself into the surrounding lines as much as possible. You can toggle
between a deep fill and a regular fill at any time by pressing on the Shift key
while using the paint fill tool..

· Show Brush Diameter:  When this setting is active, every time you select
a paint tool, the diameter of the brush is displayed as a round circle in the
viewing area. This is very useful for viewing the size of the brush in relation
to the thickness of the lines on your drawing.

· Graphics Tablet: As long as you have a graphics tablet connected, CTP
will activate these two functions: Pen Pressure changes Brush Size and
Pen Pressure changes Brush Opacity. Please take a look into the
integrated CTP help system to learn more about the use of a graphics tablett.

Note: The above functionality is 100% compatible to professional WACOM
tablets, such as the Intuos series.
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A. Shortcut Keys

A.1. Paint

Space bar Press it at any time, and keep it pressed, to move
around the visualization area with the left mouse
button pressed.  To zoom in/out the area, click on
the  right  mouse  button.  Upon releasing it, you
will retrieve the operation you had selected
previously.

Caps Lock Press it to change the cursor from any paint tool
icon to a cross which will allow you to paint with
greater accuracy. Press this key again to retrieve
the normal cursor.

A Select the airbrush tool.

B Select the paintbrush tool.

C Select the fit to window display mode.

E Select the eraser tool.

H Select the move display area tool.

I Select the get color tool.

K Select the fill tool.

L Select the line tool.

X Select the real size display mode.

Z Select the zoom tool.
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Alt + 1 Palette Browser: RGB by Name (On/Off).

Alt + 2 Palette Browser: RAL by Number (On/Off).

Alt + 3 Palette Browser: RAL by Name (On/Off).

Alt + 4 Palette Browser: RGB by HEX (On/Off).

Alt + 5 Palette Browser: RAL by HEX (On/Off).

A.2. Exposure and Storage Sheets

Space bar Press it at any time, and keep it pressed, to move
the Exposure and Storage Sheets.  Clicking on the
right mouse button will activate the zoom tool. 

+ Increment repetitions.

- Decrement repetitions.

Ctrl + C Copy.

Ctrl + F Find.

Ctrl + N New Scene.

Ctrl + O Open Scene.

Ctrl + P Print.

Ctrl + S Save Scene.

Ctrl + V Paste.

Ctrl + X Cut.

Ctrl + Z Undo.
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Ctrl + Up/down 
cursor keys Use these keys to jump to the previous/next

master cell.

F2 Changes cell’s code.  Also, by double clicking on
the cell to be changed.

R Reverse cells.
S Toggle sheets.

U Unlink a range of cells.

Mouse wheel Vertical scroll. 
Forward = Up. Backward = Down. 

Shift + Horizontal scroll. 
Mouse wheel Forward = Left. Backward = Right.

Strg + Zoom. 
Mouse wheel Forward = Zoom out. Backward = Zoom in.

A.3. Color Model Archive (CMA) area

Space bar Press it at any time, and keep it pressed, to move
the visualization color model area. Clicking on
the right mouse button will activate the zoom
tool. Upon releasing it, you will retrieve the
operation you had selected previously.

I Select the get color tool.

Z Select the zoom tool.
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A.4. Animation Curves’ area

Space bar Press it at any time, and keep it pressed, while
dropping the mouse to move the visualization
curves’ area.  Use this same method, but with the
right mouse button, to use the zoom tool.

Ctrl To add keyframes, move the mouse to the point
where you want to make the addition.  Hold the
Ctrl key and click on the left mouse button.  Use
this same method to remove keyframes.

Shift To move keyframes in time from one frame to
another, press the Shift key and, while holding on
the left mouse button, drag the keyframe to the
desired position.  Release the left mouse button to
drop it.

If you wish to level horizontally both keyframe
tension points, press the Shift key and drag one of
the tension points.

TAB Hotkey support for the camera graph parameters
Pan, Zoom, Blur, Rotation and Opacity has been
added. Once one of these parameters is active, it
is easy to step clockwise by pushing the TAB key
on  the  keyboard.  It  is possible to step counter 
clockwise   by   holding  the SHIFT key  while 
pushing the  TAB key  at the  same time. Either 
direction will always be performed in an infinite
loop. 
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B.1. Recommended Equipment

To use CTP, you do not need a special computer system. In principle, any
“actual” PC of the last three or four years will be all you need to use CTP
successfully.

The following operating systems are supported:

Windows XP
Windows Vista (*)
Windows 7 (*)
Windows 8 (*)
Parallels Desktop for Mac, VMWare or Boot Camp

(*) CTP will work on the 32 bits or 64 bits versions of Windows Vista,
Windows 7 or Windows 8.

CTP is designed to take full advantage of all system resources. Any
improvement with regard to the minimum characteristics of the processor,
memory, graphic or disk can considerably improve the final result.

CTP supports the TWAIN scanning standard. This means that any 100%
TWAIN compatible scanner should work flawlessly with CTP. Use an A4 or A3
scanner with USB or SCSI interface. Scanners with an Automatic Document
Feeder (ADF), that is supported through the TWAIN driver, are fully
compatible to CTP´s scanning capabilities. 

CTP supports the Video for Windows compatible Osprey video cards from
Viewcast to be used for line testing using an analog video camera. 

Alternatively, high quality USB webcams can also be used for line testing.  

Last but not least, a graphics tablet may be useful to directly draw in the CTP
software. CTP supports all Windows compatible graphics tabletts with USB or
RS232 interface. WACOM professional graphics tablets, such as the Intuos
series, are fully supported.
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B.2. Osprey video cards

For realtime video capturing, CTP currently supports the so called “Video For
Windows”, which is a former Microsoft standard. There are only very few video cards
available, that offer drivers for “Video For Windows”. CTP supports the Osprey Video
capture card family for live video input. Viewcast, the manufacturer of the Osprey
Video provides many capture cards, some of which are made especially for internet
streaming and might not be compatible with the Video For Windows standard. Please
make sure that the card model is compatible with VFW before purchasing the product,
as with any other capture card model on the market. Make sure you check for their
“Legacy Driver”, that is Viewcast´s way to describe the “Video For Windows”
functionality.

A relatively good alternative to expensive cards available today is the Osprey-100
capture card, or the Osprey-200 capture card with Audio capture as well. Those two
models have been tested to work with CTP. 

What is the purpose for using Osprey-100/200 video cards in CTP? 

Video capturing in CTP is the preferred method by profesionals to do so called line
tests. Doing line tests allows to quickly check the drawings for continuity and
preciseness of movements of characters. And instead of having to scan the drawings,
which is quite time consuming, line test professionals prefer a camara attached to a
rostrum and put drawing by drawing under the camera´s lens. Taking and importing
these pictures into CTP takes fractions of a second only and speeds up the process of
checking the drawings in great ways.

Osprey cards allow to use cheap analog video cameras. These cameras usually have
good manual lenses, are very easy to set up and use and the results of capturing the
drawings are perfect for the purpose of doing line tests!
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Frequently Asked Questions

In this section you will find answers to the most common, frequently asked
questions. The answers we are giving here, often will give you useful
examples and solutions and will hopefully make it easier for you to get the
most out of CTP. 

Of course, we are well aware, that it is almost impossible for us to find
answers to every question that might come up. But we hope, that the
following questions and answers will match many of your needs.

However, should you have any further questions, or should you have a great,
useful tip and trick, you would like to share with other CTP users, contact us,
please. We will make sure to help you and pass on your CTP tricks and tips
to others.

C.1. Frequently Asked Questions

- How do I copy my work from one scene to another? 

- Can I merge all my scenes into one large scene? Is this a good idea? 

- How can I get more than one level of Undo in CTP?

- What's the difference between deleting and removing a cell? How do I  
switch between deleting and removing a cell? 

- When scanning my images, I'm not satisfied with the quality of the lines.
How do I improve the line quality on my scanned images? 

- Can CTP automatically detect the peg holes in my drawings? How do I  
activate automatic peg-hole detection? 

- My scanner doesn't seem to work with CTP. What do I do?

- How do I change the color of my lines in my drawings?
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- Can I substitute higher-resolution images for lower resolution images in the 
exposure sheet? I want to use the timing from my rough line-tests with  
higher-resolution scanned images. 

- How can I increase the resolution of images captured from video?

- What is the largest resolution image that CTP can export?

- CTP crashes when I export sound! What do I do?

- When I output a QuickTime movie from CTP, the audio track doesn't play 
back properly.

- How do I create shadows in CTP?

C.2. Tips and Tricks

C.2.1. How do I copy my work from one scene to another?

To copy from one scene to another, simply start up another CTP session (you
can have more than one running at one time). Now copy one layer at a time
from one exposure sheet to the next, then you save your new scene and end
the other CTP session. Once the copy has been made, you can close the first
session and proceed with your work. 

1.) In the START menu in the Windows taskbar, start up CTP. 
2.) Open the scene you want to copy material from. 
3.) In the START menu in the Windows taskbar, start up CTP again. 
4.) In the new CTP session, open the scene you want to receive the copied
material. 
5.) Switch to the first CTP session. In the Exposure sheet, select the entire
image layer you want to copy, then select COPY from the EDIT menu. 
6.) Switch to the second CTP session. Now select an entire empty image layer
in the exposure sheet, then select PASTE from the EDIT menu.
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Note: You can copy more than one image layer at a time, and camera and
audio layers too, but the layers in the receiving scene must be in the same
order as the original scene. For example, in Scene 1, suppose layer A, which
contains images, is active; Layer B, which is empty and inactive; and a
camera layer that is active and affects layer A. Now suppose you select all the
frames in layer A, layer B, and the camera layer, and copy them. When you
paste them into the second scene, you must paste them into layers that are in
a similar order to the first scene - two image layers next to a camera layer.
Otherwise an error message appears: "Copy and Paste range of layers do not
match", or "One or several of the cells/layers you are trying to copy doesn't
match with the actual exposure sheet layout."

C.2.2. Can I merge all my scenes into one large scene? Is this a good idea?

Yes, in principle you could put more than one scene together into one big
scene. But keep in mind that the longer your scene (i.e. the more frames and
the more layers you have), the more your computer's resources are used up
when you have to render out the final animation.

For example, let's say you wanted to take all your scenes and string them
together into a full 22-minute episode. You would need an inordinate amount
of RAM to put it together. Even with the maximum amount of RAM, it most
likely will not even work, and crash your machine.

CTP is not designed to be a video editing package like typical video editing
software packages. They do not physically load every image into memory
when rendering, because they are not compositing multiple image layers
together like CTP does.
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C.2.3. How can I get more than one level of Undo in CTP?

In some graphics applications, you can pre-set the number of levels of "undo".
A certain amount of RAM is then dedicated as a buffer that keeps those
commands in memory. But these applications usually only deal with one
image at a time.

CTP deals with multiple images, which presents a huge buffering problem.
Lets say you paint an image, then you move to the next image. The last
commands applied to the first image and the state of the image after each
process would have to be saved in the buffer. Now, if I go to the second
image, the buffer will have to increase even more to take into account all the
changes I make to the second image. Having multiple undos over multiple
frames would quickly eat up all the RAM in a very short time and cause the
operating system to crash.

How we went around this problem is to have one level of undo per action at
a time, and we incorporated the ok! and the no! buttons as a reasonable
compromise. For example, if you begin painting a cell, the ok! and no!
buttons become active. You can only undo the last action performed, but if
you press the no! button, then all the actions you performed since you started
using the paint tool on that particular image are discarded.

Now, if you go to another image in the sequence by selecting it, it is the same
as pressing the ok! button, which indicates that you are happy with the
changes you made for that particular frame, since you started working on it.

The ok! and no! buttons are also very powerful, when you select multiple
frames to perform processes globally over the entire range of frames. For
example, if I select a whole range of cells in the exposure sheet and use the
REPLACE COLOR button on the first frame in the sequence, if I press the
ok! button, a dialog box will pop up, asking if I want to apply the change over
the selected range of cells. 
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C.2.4. What's the difference between deleting and removing a cell? How
do I switch between deleting and removing a cell?

Deleting selected cells erase their contents, but leaves the cells empty in the
exposure sheet. Removing selected cells also erases them, but if there are
subsequent cells in the sequence that follow the deleted cells, they are pushed
up in the exposure sheet to follow the previous cells to the ones you deleted.

The Delete key can perform both a DELETE CONTENTS or a REMOVE,
depending on how you have set up your ON DELETE CELLS preferences. In
the TOOLS menu, select OPTIONS. Click on the SHEET SETTINGS tab in
the options dialog box.

If you have set the ON DELETE CELLS options to DELETE CONTENTS,
then pressing the Delete key will delete the cell. If you have set the options to
REMOVE, then pressing the Delete key will remove the cell. 

C.2.5. When scanning my images, I'm not satisfied with the quality of the
lines. How do I improve the line quality on my scanned images?

Please note: What follows is somewhat abstract and very visual.

To increase or decrease the resolution of your scanned images, you use the
RESOLUTION function in the SOURCE section of the Import images from
scanner tools. The value that you enter in the RESOLUTION box represents
the number of fields that you plan on zooming or trucking the camera into
your sequence of images. The smaller the value you enter, the higher the
resolution of the image being scanned (the DPI number appears below this
function). Reduce the resolution field number to improve the resolution of
your line.

Activate the FIELD CHART button, which shows a field chart exactly the
same size as the output resolution that you defined when you created your
scene. For example, the "Villy the Devil" demo scene that comes with CTP is
in PAL video format, with a resolution of 768 X 578 pixels, in which a 9-field
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field guide is placed. As you lower the field number in the RESOLUTION
box, you'll notice that the field chart reduces in size as well. That's because
the higher the resolution, the bigger the image that is imported into CTP.

In other words, the higher resolution image represents the maximum zoom
you will attempt, or the closest you will want to zoom into on your image.
Once you import the image and place it into the exposure sheet, you must use
the camera to zoom OUT from the drawing to make it fit into the output
resolution, essentially reducing the size of the drawing such that it fits into
view. Now that when you begin to zoom into the image, the line quality
remains smooth, up until you reach the maximum zoom level determined by
the resolution of the image you just scanned.

Note: This method only uses field numbers as a reference to determine the
proportion of the imported image to the output resolution. The scanner,
because it digitizes the image into pixels of varying numbers depending on
the resolution you want, does not behave in the same way as a camera, which
uses an optical system based on distances measured in field depths. So, for
example, if you enter a value of 6 fields, and your scene was created at 9
fields, then the image you scan will really represent a proportional size
difference at the maximum resolution needed to get the line quality you need
for the shot, not an actual 9-to-6 field zoom in the traditional sense. It is a
different system, using different physics, because a scanner can never behave
exactly like a camera.

Once you have set your resolution, now it is time to set your filters to make
sure the line quality is clear, and that all of the white areas on your drawings
become transparent. Click on the Import Setup button to choose the right filter
for your line. 

The ONLY PREFILTER is the most flexible of all the filters:

1.) The Prefilters Black Level selection button has an image of a black
eyedropper on it. When you click on the button, a black eyedropper-shaped
cursor appears. In the viewing area, click on the line on your drawing to select
the dark areas of your line drawings. 
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2.) The Prefilters White Level selection button has an image of a clear,
transparent eyedropper on it. When you click on the button, a transparent
eyedropper-shaped cursor appears. In the viewing area, click on the areas of
your drawing to select the areas that you want to appear transparent (i.e. the
blank areas of your drawing that you want to fill with paint later). 

3.) The Auto button makes an automatic calculation of the Shadows and
Highlights (dark and light areas) on your line drawings. The Auto tool
automatically adjusts the image so that the darker grays appear black and the
brighter grays go up to white (transparent). The rest of the colors will be
adjusted accordingly. 

4.) If you sample the black levels and white levels on your line drawings, and
you sample the wrong areas, the Reset button clears all of the Prefilter
settings so that you can start over. The Reset tool simply resets all values so
that no Prefilter is applied.

To use the Prefilter tools effectively, turn on the Transparency button (the red
button with the line through it). When you click on this button, all the pure
white areas on the image you are scanning are displayed in red. Wherever you
see red, those areas are considered to be 100% transparent by the CTP
software. It is these transparent areas that will be painted in later. The red
areas provide a visual reference, letting you see exactly which areas of your
drawing are truly white, and which ones are gray or off-white. Any part of
your drawing that is not pure white will be considered as part of a line or as
an opaque area by the software. The image transparency button is very useful
in conjunction with the prefilter options, because it lets you see the contrast
between the lines and the white areas on the drawing very easily. Now you
can keep on clicking on the dark areas with the Black Level selector (the
black eyedropper) and the lighter areas with the White Level selector (the
clear eyedropper) until all the lines in the image are surrounded in red. 

Note: Always leave some white between the black lines and the red
surroundings, this adds smoothness to the lines.
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C.2.6. Can CTP automatically detect the peg holes in my drawings? How
do I activate automatic peg-hole detection?

Yes, CTP does have very powerful peg hole detection tools. There are two
scanning scenarios, depending on what type of scanner you have:

1.) You have a regular flat-bed scanner. Automatic peg detection is not useful
in this scenario. You simply stick a peg bar down on the scanner, so that when
you place your drawings on them, they are always in the same place. Activate
the FIELD CHART button too and place the center exactly where you want
the center of your scanned drawing to be. Then you can activate the AUTO
SCAN button to determine the number of scans that will be made, and you
can flip through each drawing one at a time, scanning each one individually
for as many times as you specified. If you activate the AUDIBLE
CONFIRMATION check box, CTP will even make a "swooshing" sound,
indicating when you should change the paper between scans. 

2.) You have a scanner with a multi-page automatic feeder, in which case you
activate automatic peg bar detection.

Here's how it works:

1.) If you have a scanner with a multi-page automatic feeder, preview the first
image in the sequence. In the SOURCE menu of the import images from
scanner tool, make sure that the AUTO FEEDER and MULTIPLE PAGES
check boxes are activated. 

2.) Activate automatic peg bar detection using the PEGS BAR button in the
import image from scanner tool. Please note that you must place a thin strip
of black tape on the opposite side of the scanner sensor. The reason you must
do this is, that the peg holes must be made to stand out against the usually
white background. As the paper travels across the sensor, the little strip of
black that is behind the paper, makes the peg holes stand out enough for CTP
to detect them. Otherwise, the peg holes wouldn't appear at all. 
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3.) Since the computer cannot make a judgment as to which pixels in the
drawing are important, you must specify where the center of the imported
images is by activating the FIELD CHART button and placing the center of
the field chart over the center of your artwork. Click on the FIELD CHART
button again to make it appear and disappear, it will always remain centered
wherever you place it in relation to the position of the peg holes. 

4.) Click on the FIELD CHART button to make the field chart disappear from
view so you can use the filters on your artwork. 

5.) Adjust your filters on the first image, then choose a destination layer in the
storage sheet. 

6.) Click on the IMPORT button. The first image and all the subsequent
images in the auto feeder will be scanned, aligned, filtered, and placed in the
storage sheet.

7.) Click on the CLOSE button once you have finished scanning. You will be
prompted to either save your scan settings with the scene file (if you plan to
do more scans later), or you may dismiss the scan settings as you see fit.

C.2.7. My scanner doesn't seem to work with CTP. What do I do?

CTP works with any scanner that has a TWAIN driver. This is the case with
almost every scanner on the market. In some cases, a scanner might appear
not to work properly with CTP, but it is inevitably caused by a poorly-
implemented scanner driver. We use the CFM TWAIN Driver wherever
possible in the case of a faulty driver causing bizarre behavior. The CFM
TWAIN driver can be obtained from here: http://www.cfm.de
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C.2.8. How do I change the color of my lines in my drawings?

If you want the lines to be a different color instead of black, you can re-color
the line in the exposure sheet:

1.) Select a sequence of images. 
2.) Select the VIEW LINE button in the view controls. 
3.) Select a color. 
4.) Select the FILL paint tool. 
5.) Press the SHIFT key and click on the line. All the lines in the drawing are
now colored the same. 
6.) Press OK. CTP will prompt you and ask if you want to change the line
color on all the selected images in the sequence.

C.2.9. Can I substitute higher-resolution images for lower resolution
images in the exposure sheet? I want to use the timing from my rough
line-tests with higher-resolution scanned images.

Yes, do the following:

1.) Back up your scene under a different name to make absolutely sure you
don't accidentally delete anything that you might want to keep later.

2.) Delete the rough pencil-test images from the storage sheet that correspond
to the images in the exposure sheet you want to replace. If you have renamed
or unlinked the cells in the exposure sheet, then rename them to match the cell
code of the originals.

3.) Acquire the higher-resolution images using the scanner, and give them
exactly the same cell code as the drawings you just deleted in the storage
sheet.

4.) Select your images in the exposure sheet that you want to have replaced
with the higher resolution images you scanned.
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5.) Select the reload from storage button on the toolbar (it's in the upper
right side of your screen). The old images in the exposure sheet will be
replaced by the new images in the storage sheet.

C.2.10. How can I increase the resolution of images captured from video?

This is impossible using video capture, because the video camera used to
capture the image has a fixed resolution that cannot be adjusted, period.

A PAL video camera cannot capture an image greater than 768 x 576 pixels,
and an NTSC video camera cannot capture an image greater than 720 x 540
pixels. Furthermore, most video I/O boards capture even fewer lines of
resolution than that. This is a technological limitation of video formats. To get
higher resolution images into your computer, you must use a scanner.

C.2.11. What is the largest resolution image that CTP can export?

CTP is resolution independent, meaning that it can support different
resolutions for different projects, whether they be film or video. The most
common film image resolutions that people work with are 2K and 4K.

CTP supports images up to 8K in size. The film stock for this resolution
would require very expensive cameras and projectors, making it prohibitively
expensive to produce such a film.

When you create a new scene in CTP, you define the output resolution you
want to work in. If you select OTHER as your resolution, you can pick
exactly the pixel size you need, both horizontally and vertically. CTP
automatically analyzes your computer system and checks to see if it has
enough physical resources to work effectively at that resolution.

Note: Film resolution images are rather large, and require a fairly substantial
amount of RAM for your computer to manipulate them in great numbers. If
you plan to output to film, it is recommended that you obtain as much RAM
as you can for your computer, the more the better.
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This table lists some (but not all) common resolutions used by the film and
video industries: 
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C.2.12. CTP crashes when I export sound! What do I do?

We have discovered an older version of a particular .DLL file that sometimes
causes CTP to crash. Once it is replaced, the problem is fixed.

The .DLL files are found in the C:\WINDOWS\SYSTEM32.

The .DLL in question is the MFC42.DLL file. In C:\WINNT\SYSTEM32,
right-click on the MFC42.DLL file and select PROPERTIES. In the dialog
box that appears, select the VERSION tab. It must be version 6.* or later, or
else it will cause audio conflicts in CTP.

If your MFC42.DLL file is an earlier version than 6.*, then it must be
replaced with a current version, which can be found on a newer
release/service pack of the Windows CD/DVD-ROM, or directly from
Microsoft.  

C.2.13. When I output a QuickTime movie from CTP, the audio track
doesn't play back properly.

This is an intermittent problem that has nothing to do with CTP, but with how
QuickTime is set up on your computer. What follows was reprinted from the
Apple website, which can be found at the following link:

http://www.apple.com/quicktime/

The default QuickTime sound settings work for most computers. However, if
you experience sound drop-out problems on your computer, here are some
things you can try.

If DirectSound is available for your computer, make sure you have the latest
sound driver and the current version of Direct X. If you still experience sound
problems, adjust the size of the sound buffer QuickTime uses. Larger buffers
reduce the chance of drop-outs, but increase latency for interactive uses of
sound. 
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Adjusting the size of the Sound Buffers

1.) Open the Control Panels of your Window operating system. 
2.) Open QuickTime Settings. 
3.) Select the Sound Out panel.
4.) Select the WaveOut or DirectSound device (Depends on your computer
configuration). 
5.) Click on the Options button at the bottom of the control panel. 
6.) Adjust the settings. 
7.) Test the movie you were experiencing problems with. 
8.) Keep adjusting the settings until the audio problem is corrected.

DirectSound Settings 

The size of the sound buffer is set in milliseconds. Increase the buffer size
until the drop-out is corrected. 

WaveOut Settings

There are two numbers to adjust, the number of buffers and the size of each
buffer in milliseconds. Adjust the number of buffers until any drop-outs are
corrected. If you hear a stuttering, increase the individual buffer size until the
stuttering is corrected.

One place to check for latest drivers and Direct X at
http://www.microsoft.com/

Hint: Search for Direct X, Drivers, Sound & Multimedia. 
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C.2.14. How do I create shadows in CTP?

CTP does not generate shadows automatically, they are created directly from
your artwork. You must physically draw the limits of where you want the
shadow directly on your animation drawings, in a color that contrasts well
with black. We have found that red lines work well.

1) When you select the IMPORT IMAGES FROM SCANNER button, in
the SOURCE section, you must have the SCAN TYPE set to TRUE
COLOR. Set your SCAN TYPE to TRUE COLOR. If your scanner is a
black and white or greyscale scanner only, the shadow lines feature will not
work.

2) Click on IMPORT SETUP, select LINE IMAGE, and activate the
SHADOW LINES check box underneath. CTP will scan in two layers, one
layer with just black lines, and one layer with both the black lines and the
colored lines together. To see how CTP separates the colored line from the
black line, press the SHOW SHADOW icon to toggle the display of the
shadow line. 

3) After you have placed the two layers in the storage sheet, press CLOSE.
Drag and drop each layer into the exposure sheet. In the layer containing only
the black lines, ink and paint your character as usual. 

4) In the layer containing both colored lines and black lines, fill the closed
areas that represent where you want your shadows to be with a dark color. 

5) Select all the cells in the layer. Click on the SHOW LINE button in the
VIEW controls. Select the ERASER tool, press the SHIFT key on your
keyboard, and click on the viewing area. All the lines in the drawing should
be erased, leaving the fill color. Press the ok! button, and CTP will ask you if
you want to erase all the lines in all the drawings you have selected. Select
YES.
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6) Now you have just the shadows, but the edges of the shadows are very
hard. Make sure all the cells in the layer are still selected, then press the
BLUR tool in the IMAGE section. Apply a blur, then press the ok! button.
CTP will ask you if you want to apply the blur to all the drawings you have
selected. Select YES. 
7) Now you have soft shadows, but they are completely opaque. Make sure
all the cells in the layer are still selected, then press the OPACITY tool in the
IMAGE section. Change the opacity value to make the shadow more
transparent, then press the ok! button. CTP will ask you if you want to apply
the opacity value to all the drawings you have selected. Select YES. 

8) Place your shadow layer to the left of your character layer, so that the semi-
transparent shadow appears over your character. 

Please consult the "Villy the Devil" demonstration scene that comes with CTP
to view an example of shadows being used.  
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